Before operating the unit, please read this Handbook and "Instruction Manual" thoroughly, and retain them for future reference.
Notes on using your camera

Types of “Memory Stick” that can be used (not supplied)
The IC recording medium used by this camera is a “Memory Stick Duo”. There are two types of “Memory Stick”.

“Memory Stick Duo”: you can use a “Memory Stick Duo” with your camera.

“Memory Stick”: you cannot use a “Memory Stick” with your camera.

Other memory cards cannot be used.
- For details on “Memory Stick Duo”, see page 120.

When using a “Memory Stick Duo” with “Memory Stick” compatible equipment
You can use the “Memory Stick Duo” by inserting it into the Memory Stick Duo Adaptor (not supplied).

Notes on the “InfoLITHIUM” battery pack
- Charge the battery pack (supplied) before using the camera for the first time.
- The battery pack can be charged even if it is not completely discharged. Also, even if the battery pack is not fully charged, you can use the partially charged capacity of the battery pack as is.
- If you do not intend to use the battery pack for a long time, use up the existing charge and remove it from your camera, then store it in a cool, dry place. This is to maintain the battery pack functions.
- For details on the usable battery pack, see page 122.

Carl Zeiss lens
This camera is equipped with a Carl Zeiss lens which is capable of reproducing sharp images with excellent contrast. The lens for this camera has been produced under a quality assurance system certified by Carl Zeiss in accordance with the quality standards of Carl Zeiss in Germany.

Notes on the LCD screen and lens
- The LCD screen is manufactured using extremely high-precision technology so over 99.99% of the pixels are operational for effective use. However, there may be some tiny black points and/or bright points (white, red, blue or green in color) that constantly appear on the LCD screen. These points are normal in the manufacturing process and do not affect the recording in any way.
- Exposing the LCD screen or the lens to direct sunlight for long periods may cause malfunctions. Be careful when placing the camera near a window or outdoors.
- Do not press against the LCD screen. The screen may be discolored and that may cause a malfunction.
- Images may trail across on the LCD screen in a cold location. This is not a malfunction.
- Be careful not to bump the lens, and be careful not to apply force to it.

The pictures used in this Handbook
The photographs used as examples of pictures in this Handbook are reproduced images, and are not actual images shot using this camera.
# Table of contents

Notes on using your camera .................................................................2
Basic information ..................................................................................7
Identifying parts ....................................................................................10
Indicators on the screen .......................................................................12
Changing the screen display .................................................................16

## Basic Operations

Shooting images easily (Auto adjustment mode) ..................................18
Viewing/deleting images ......................................................................23
How to operate – home/menu ...............................................................26
Menu items ............................................................................................30

## Using the shooting functions

Changing the recording mode ...............................................................31
Shooting still images (Scene selection) ...............................................32
Shooting menu ......................................................................................34
  - Camera: Selecting the still image camera mode
  - Scene: Selecting the Scene Selection mode
  - EV: Adjusting the exposure
  - Focus: Changing the focus method
  - Metering Mode: Selecting the metering mode
  - White Bal: Adjusting the color tones
  - ISO: Selecting a luminous sensitivity
  - REC Mode: Selecting the continuous shooting method
  - Flash Level: Adjusting the amount of flash light
  - Camera Set.: Changing setup items for shooting
### Using the playback functions

Playing back images from the home screen ......................................................... 41
Viewing menu ...................................................................................................... 45
- Album/Folder: Go To Album/Go To Folder, Combine Album, Split Album
- Manage Images: Delete, Protect
- Edit Image: Rotate, Resize
- Label: Add Label, No Label
- Find: Keyword, Similar Images
- Print
- Slide Show
- Import/Export
- Details

### Changing the settings

How to change the settings .............................................................................. 54
- Media Tools ................................................................................................... 56
- General ........................................................................................................... 56
  - Media Space
  - File Number
- Memory Stick ................................................................................................. 57
  - Format
  - Create REC. Folder
- Internal Memory .......................................................................................... 59
  - Scan Images
  - Format
- Settings ......................................................................................................... 61
- Main – Sound .............................................................................................. 61
  - Beep
  - AVLS
- Main – Screen .............................................................................................. 62
  - Language
  - HOME Design
- Main – Preferences ...................................................................................... 63
  - Initialize
  - USB Connect
  - Function Guide
  - LCD Brightness
  - Video Out
# Table of contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clock Set</td>
<td>65</td>
</tr>
<tr>
<td>Camera</td>
<td>66</td>
</tr>
<tr>
<td>Music</td>
<td>69</td>
</tr>
<tr>
<td>Network</td>
<td>70</td>
</tr>
</tbody>
</table>

## Camera

<table>
<thead>
<tr>
<th>Feature</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image Size (Photos)</td>
<td>Red Eye Reduction</td>
</tr>
<tr>
<td>Image Size (Movies)</td>
<td>AF Illuminator</td>
</tr>
<tr>
<td>AF Mode</td>
<td>SteadyShot</td>
</tr>
<tr>
<td>Digital Zoom</td>
<td>Auto Orientation</td>
</tr>
</tbody>
</table>

## Music

<table>
<thead>
<tr>
<th>Feature</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Repeat</td>
<td>LCD Auto Off</td>
</tr>
<tr>
<td>MEGA BASS</td>
<td></td>
</tr>
</tbody>
</table>

## Network

<table>
<thead>
<tr>
<th>Feature</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Point</td>
<td>Nickname</td>
</tr>
<tr>
<td>Network Power Save</td>
<td>Img exchg password</td>
</tr>
</tbody>
</table>

### Viewing images on a TV screen

Viewing images on a TV screen .............................................................. 73

### Using your computer

Enjoying your Windows computer .......................................................... 75
Installing the software (supplied) .......................................................... 77
Using the “Album Editor” (supplied) ......................................................... 78
Using the “Picture Motion Browser” (supplied) ........................................ 82
Connecting the camera and your computer with Mass Storage .............. 86

### Using a network

What you can do with a network connection ........................................... 88
Assigning a nickname to the camera ..................................................... 90
Collaboration Shot ............................................................................... 91
Picture Gift ......................................................................................... 93
Viewing images via a Wireless LAN ..................................................... 95
Table of contents

**Printing still images**
- How to print still images ......................................................... 97
- Printing images directly using a PictBridge compliant printer .......... 98

**Listening to music**
- Listening to music .................................................................. 101

**Troubleshooting**
- Troubleshooting ...................................................................... 104
- Warning indicators and messages .............................................. 115

**Others**
- To use your camera abroad — Power sources ......................... 118
- On the “Memory Stick” .............................................................. 120
- On the “InfoLITHIUM” battery pack ........................................ 122

**Index**
- Index ..................................................................................... 123
Basic information

The camera is equipped with an internal memory of approximately 2 GB, which enables a large number of images to be stored in the camera. The images can also be stored in a “Memory Stick Duo” (not supplied).

- Album images are very small, so you can store a lot of images in the camera. This is convenient to view Images later. Album Images are always recorded.
- For movies, the first cut of a movie is recorded on an album as an Album Image.
Basic information

**Automatic image management**

This camera automatically classifies images into albums depending on the shooting intervals and frequency.
You can search the images by albums for your convenience.
The automatically created albums can be divided or combined manually.

<Example>

<table>
<thead>
<tr>
<th>1st album</th>
<th>2nd album</th>
<th>3rd album</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of images</td>
<td>Time (Date)</td>
<td></td>
</tr>
</tbody>
</table>

![Diagram showing image classification and album management](image)

To name an album
→ Use the “Album Editor” (supplied)
To put these two together
→ Combine albums

To divide one here into two
→ Divide an album

![Diagram showing division and combination of albums](image)

2007 New Year

2007-01-15

2007-01-15-(2)

The album has a new name
The two albums are combined
The album is divided at the specified spot
Basic information

Delete

When deleting an image, you can choose to delete just the Original Image, or delete the Original and Album Images at the same time.

Use with a Computer

This camera is equipped with various search functions. With the software on the supplied CD-ROM, you can use more advanced search functions.

With the “Album Editor”, you can:
- Edit labels or comments
- Copy images stored on a computer to the camera
- Import MPEG4 movie files to the camera
- Restore the data of the camera from a backup of a computer (Restore)

You can enjoy a lot more images with ease!
Identifying parts

See the pages in parentheses for details of operation.

**Camera**

1. POWER lamp/POWER button
2. Shutter button (19)
3. WLAN (Wireless network) button (91)
4. Flash (20)
5. Self-timer lamp (21)/AF illuminator (67)
6. Hook for wrist strap
7. WLAN antenna (internal)
8. OPEN (CAMERA) lever (18)
9. Microphone
10. Lens
11. Lens cover
12. (Headphones) jack (103)

1. For shooting: Zoom (W/T) button (19)
   For viewing: (Playback zoom) button/ (Index) button (23, 24)
2. LCD screen (16)
3. (Movie/Photo) button (18)
4. (Playback) button (23)
5. For shooting: (Flash) button (20)
   For playing back music: Hold button (102)
6. (Macro/Magnifying Glass) button (20)
7. (Image Size/Delete) button (22, 23)
8. (Self-timer) button (21)
9. Flash charging (20)/CHG (charge) lamp
10. DISP (Screen display switch) button (16)
11. Control button
12. BACK button
   - Returns to the previous screen.
13. MENU button (29)
Identifying parts

14 HOME button (26)
15 Battery/“Memory Stick Duo” cover
16 Battery insertion slot
17 Battery eject lever
18 Multi connector
19 Tripod receptacle
  • Use a tripod with a screw length of less than 5.5 mm (7/32 inch). You will be unable to firmly secure the camera to tripods having screws longer than 5.5 mm (7/32 inch), and may damage the camera.
20 RESET button (104)
21 Speaker
22 Access lamp
23 “Memory Stick Duo” slot

Cyber-shot Station
This is used when charging the battery pack or connecting the camera to a TV or a computer, etc.

How to connect
Connect the camera as illustrated.

• Make sure to install the camera all the way in firmly.

How to disconnect
Grasp the camera and the Cyber-shot Station as illustrated and disconnect the camera.

• Be sure to turn off the camera before you connect the camera to the Cyber-shot Station or disconnect the camera from the Cyber-shot Station.

1 Camera connector
2 CONNECT button (86)
3 DC IN jack
4 (USB) jack
5 A/V OUT (STEREO) jack
Each time you press the DISP (Screen display switch) button, the screen status changes. See the pages in parentheses for details of operation.

**When shooting still images**

1. Display 60Min
   - **Indication**: Battery remaining
   - **Details**: Only 60Min is indicated, depending on a mode.

2. Recording media
   - **Indication**: Recording folder (57)
   - **Details**: This does not appear when using the internal memory.

3. Recording folder (57)

4. SteadyShot (68)

5. Radio field strength with a network

**When shooting movies**

1. Display
   - **Indication**: The setting that has been selected by the menu (16)

2. Image size (22)

3. Remaining number of recordable images

4. Maximum recording time

5. Zoom scaling (19, 67)
## Indicators on the screen

### Display Indication

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>● (Green)</td>
<td>AE/AF lock (19)</td>
</tr>
<tr>
<td>● (Red)</td>
<td>Recording a movie</td>
</tr>
<tr>
<td>Standby</td>
<td>Standby a movie</td>
</tr>
<tr>
<td>00:00:00</td>
<td>Recording time</td>
</tr>
<tr>
<td>NR</td>
<td>NR slow shutter</td>
</tr>
<tr>
<td></td>
<td>• When the shutter speed drops below a certain speed in low light conditions, the NR (Noise Reduction) slow shutter function activates automatically to reduce the picture noise.</td>
</tr>
<tr>
<td>125</td>
<td>Shutter speed</td>
</tr>
<tr>
<td>F3.5</td>
<td>Aperture value</td>
</tr>
<tr>
<td>+2.0EV</td>
<td>Exposure Value (34)</td>
</tr>
<tr>
<td>ISO 400</td>
<td>ISO number (38)</td>
</tr>
</tbody>
</table>

### Display Indication

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>C:32:00</td>
<td>Self-diagnosis display (115)</td>
</tr>
<tr>
<td>❌</td>
<td>Low battery warning (115)</td>
</tr>
<tr>
<td>+</td>
<td>Spot metering cross hair (37)</td>
</tr>
<tr>
<td>⌛️</td>
<td>AF range finder frame (35)</td>
</tr>
<tr>
<td></td>
<td>Latest recording history (16)</td>
</tr>
</tbody>
</table>

### Display Indication

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌠</td>
<td>Vibration warning</td>
</tr>
<tr>
<td></td>
<td>• Indicates vibration may prevent you from shooting clear images due to insufficient lighting. Even if the vibration warning appears, you can still shoot images. However, we recommend that you turn on the anti-blur function, using the flash for better lighting or using a tripod or other means to stabilize the camera (page 116).</td>
</tr>
<tr>
<td>⌂️</td>
<td>Self-timer (21)</td>
</tr>
<tr>
<td>🌠 🌠</td>
<td>Flash mode (20)</td>
</tr>
<tr>
<td>🌠 🌠</td>
<td>Macro/Magnifying Glass (20)</td>
</tr>
</tbody>
</table>
Indicators on the screen

When playing back

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>60Min</td>
<td>Battery remaining</td>
</tr>
<tr>
<td></td>
<td>• Only is indicated, depending on a mode.</td>
</tr>
<tr>
<td></td>
<td>The destination medium of Original Images</td>
</tr>
<tr>
<td></td>
<td>Playback folder (57)</td>
</tr>
<tr>
<td></td>
<td>• This does not appear when using the internal memory.</td>
</tr>
<tr>
<td></td>
<td>PictBridge connecting (100)</td>
</tr>
<tr>
<td></td>
<td>Search keyword</td>
</tr>
<tr>
<td></td>
<td>Index mode</td>
</tr>
<tr>
<td>12/12</td>
<td>Image number/Number of images recorded in selected folder</td>
</tr>
</tbody>
</table>

2

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>00:00:12</td>
<td>Counter</td>
</tr>
<tr>
<td></td>
<td>Playback bar</td>
</tr>
<tr>
<td></td>
<td>Movie operation guide</td>
</tr>
<tr>
<td></td>
<td>Skip/Fast-forward</td>
</tr>
<tr>
<td></td>
<td>Skip/Rewind</td>
</tr>
<tr>
<td></td>
<td>Frame-by-frame (advance)</td>
</tr>
<tr>
<td></td>
<td>Frame-by-frame (reverse)</td>
</tr>
</tbody>
</table>

2007/01/01 Information area
## Indicators on the screen

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>DSC00012</td>
<td>File number (56)</td>
</tr>
<tr>
<td>□</td>
<td>Color Detection</td>
</tr>
<tr>
<td>Face Detection</td>
<td></td>
</tr>
<tr>
<td>Label</td>
<td></td>
</tr>
<tr>
<td>2007/01/01 9:30AM</td>
<td>Recorded date/time of the playback image</td>
</tr>
<tr>
<td>Image size (22)</td>
<td></td>
</tr>
<tr>
<td>-30fps</td>
<td>Frame number per second (22)</td>
</tr>
<tr>
<td>Protect (47)</td>
<td></td>
</tr>
<tr>
<td>Comment</td>
<td></td>
</tr>
<tr>
<td>Label (49)</td>
<td></td>
</tr>
<tr>
<td>PC backup (done/undone)</td>
<td></td>
</tr>
<tr>
<td>Image analysis (done/undone)</td>
<td></td>
</tr>
<tr>
<td>Original Image (stored/not stored)</td>
<td></td>
</tr>
</tbody>
</table>
Changing the screen display

Each time you press the DISP (Screen display switch) button, the display changes as follows.

- By pressing DISP (Screen display switch) button longer, you can increase the LCD backlight (only when the camera is used with the battery pack).

**During shooting**

Indicator off  

Setting display on  

Latest recording history

- When shooting a movie, the indicators disappear from the screen. After the shooting, the screen returns to the previous status.

**During playback (single screen)**

Indicator off  

Indicators on  

Information area
Changing the screen display

During playback (Index screen)

- For details on an index screen, see page 24.

Home screen

- The background is black
- The background is white

During Collaboration Shot

- Normal
  - Displays your images and those of all other connected users in order of recording time
- Multi angles
  - Displays the images of each connected user separately

- For details on the Collaboration Shot → page 91
Basic Operations

Shooting images easily (Auto adjustment mode)

1. **Open the lens cover by sliding the OPEN (CAMERA) lever.**
   Open until it clicks.

2. **Select a mode with the  
   (Movie/Photo) button.**
   Each time you press the  
   (Movie/Photo) button, the mode changes between Movie and Photo.

3. **Hold the camera steady, keeping your arms at your side.**

Position the subject in the center of the LCD screen.
**4 Shoot with the shutter button.**

Aside from an Original Image, a small size Album Image is recorded in the internal memory (page 7).

**Still image:**
1. Press and hold the shutter button halfway down to focus.
   - The (AE/AF lock) indicator (green) flashes, a beep sounds, the indicator stops flashing and remains lit.
2. Press the shutter button fully down.
   - The shutter sounds.

**Movie:**
- Press the shutter button fully down.
- To stop recording, press the shutter button fully down again.

---

If you shoot a still image of a subject that is difficult to focus on

- The shortest shooting distance is approx. 50 cm (19 3/4 inches). Shoot in the close-up (Macro) mode or Magnifying Glass mode (page 20) when you shoot a subject closer than the shooting distance.
- When the camera cannot focus on the subject automatically, the AE/AF lock indicator changes to flashing slowly and the beep does not sound. The AF range finder frame disappears from the LCD screen. Recompose the shot and focus again.

**Subjects difficult to focus on are:**
- Distant from the camera and dark
- The contrast between the subject and its background is poor.
- Seen through glass
- Moving fast
- Reflective light or with a lustrous finish
- Flashing
- Backlit

Using the zoom

Press the zoom button.
- When the zoom scale exceeds 3×, the camera uses the Digital Zoom function.
  For details on the [Digital Zoom] settings and the image quality, see page 67.
Shooting images easily (Auto adjustment mode)

Flash (Selecting a flash mode for still images)
Press $ repeatedly until the desired mode is selected.

AUTO: Flash Auto
  Strobes when there is insufficient light or backlight (default setting)
  • No indicator appears on the lower part of the screen even if you select this setting.
$: Flash forced on
$SL: Slow synchro (Flash forced on)
  The shutter speed is slow in a dark place to clearly shoot the background that is out of flash light.
$: Flash forced off
  • The flash strobes twice. The first time is to adjust the light quantity.
  • The CHG lamp flashes while charging the flash.

Macro/Magnifying Glass (Shooting close-up)
Press $/Q repeatedly until the desired mode is selected.

OFF: Macro Off (Default setting)
  • No indicator appears on the lower part of the screen even if you select this setting.
$: Macro On (W side: Approx. 8 cm or farther (3 1/4 inches or farther), T side: Approx. 25 cm or farther (9 7/8 inches or farther))
$Q: Magnifying Glass On (Locked to the W side: Approx. 1 to 20 cm (13/32 to 7 7/8 inches))

Macro
  • Setting the zoom all the way to the W side is recommended.
  • The in-focus range becomes narrow, and the complete subject may not entirely be in focus.
  • The Auto Focus speed drops.

Magnifying Glass
  • Use this mode to shoot at even closer distances than $ (Macro) recording.
  • Burst and Exposure Bracket cannot be used (page 39).
  • The optical zoom is locked to the W side and cannot be used.
  • When you press the zoom button, the image is enlarged using the digital zoom.
**Using the self-timer**

Press repeatedly until the desired mode is selected.

- **OFF**: Not using the self-timer
  - No indicator appears on the lower part of the screen even if you select this setting.
- **10**: Setting the 10-second delay self-timer
- **2**: Setting the 2-second delay self-timer

Press the shutter button, the self-timer lamp flashes, and a beep sounds until the shutter operates.

To cancel, press again.
Shooting images easily (Auto adjustment mode)

To change the image size
Press [ ] (Image Size), and then move the control button to select the size. The default settings are marked with ✔.

<table>
<thead>
<tr>
<th>Image size</th>
<th>Usage guidelines</th>
<th>No. of images</th>
<th>Printing</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ 6M (2816×2112)</td>
<td>For prints up to A4(8×10&quot;)</td>
<td>Less</td>
<td>Fine</td>
</tr>
<tr>
<td>3:2¹ (2816×1872)</td>
<td>Shoot with 3:2 aspect ratio</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3M (2048×1536)</td>
<td>For prints up to 13×18 cm(5×7&quot;)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2M (1632×1224)</td>
<td>For prints up to 9×13 cm(3.5×5&quot;)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VGA (640×480)</td>
<td>For emailing (640×480)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>16:9² (1920×1080)</td>
<td>Display On 16:9 HDTV³</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1) Images are recorded in 3:2 aspect ratio, same as photograph printing paper or postcards, etc.
2) Both edges of the image may be cut off when printing (page 112).
3) By using a Memory Stick slot, USB connection, or via a network (page 95), you can enjoy images in higher quality.

<table>
<thead>
<tr>
<th>Movie image size</th>
<th>Frame/Second</th>
<th>Usage guidelines</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ 640×480</td>
<td>Approx. 30</td>
<td>Display on TV</td>
</tr>
<tr>
<td>320×240</td>
<td>Approx. 30</td>
<td>For emailing (320×240)</td>
</tr>
</tbody>
</table>

* The larger the image size, the higher the image quality.
Viewing/deleting images

1 Press the (Playback) button.

When the lens cover is closed, pressing the POWER button turns on the camera with the playback mode.

2 Select an image by moving the control button to ←/→.

Moving it to ← displays the previous image, and moving it to → displays the next image.

Movie:
Press ● to play back a movie. (Press ● again to stop playback.)
Holding the control button to ← to rewind and to → to fast forward.
Moving the control button to ↑/↓ to adjust the volume.

/ (Delete) button

/ (Index)/ (Playback zoom) button

(Playback zoom) button

(Playback) button

To delete images

1 Display the image you want to delete and press / (Delete).
2 Select [Original Image Only] or [Original & Album Images] with the control button, then press ●.

To cancel the deletion
Select [Exit], then press ●.

/ (Playback zoom)

To view an enlarged image (playback zoom)

Press ○ while displaying a still image.
To undo the zoom, press ○.
Adjust the portion: Moving the control button to ↑/↓/←/→.
Cancel playback zoom: Press BACK.

* If you operate the playback zoom function, the screen indicators are turned off except for the zoom scaling indicator.
Viewing/deleting images

Viewing an index screen

Press (Index) to switch to the index screen. Each time you press DISP (Screen display switch) or (Index), the screen changes as follows.

Select an image with the control button.
To return to the single-image screen, press .

To delete images in index mode

1. Press (Delete) while the index screen is displayed.
2. Select the images (below).

Selecting multiple images

After you select multiple images, you can perform the following functions on all the selected images collectively.
Delete/Print/Picture Gift/Share Images/Import/Export/Slide Show/Label/Protect

1. Select the image selection mode in each function.
   The browse screen appears.
② Select the image with the control button, then press .
   The mark is checked in the box of the image.

![Image of a dog with a checkmark in the box]

To select all the images in an album (or a folder)
Keep the control button to  until the frame of an album (or a folder) is selected, then press .
The mark is checked in the box of all the images in the album (or folder).

③ Press MENU.

④ Select [OK], then press .
   Each function is executed.

To cancel the selection
In Step ②, select the image that the mark is checked, then press . The mark is took off from the box of the image.
How to operate – home/menu

Using the home screen

The home screen is the basic screen used for accessing the various functions. You can access the home screen regardless of the shooting/viewing mode.

1 Press HOME to display the home screen.

2 Move the control button to left/right to select a category.

3 Move the control button to up/down to select an item.

4 Press ● to set.

- The home screen cannot be displayed during a PictBridge/USB connection.
## The home list

Pressing the HOME button displays the following items. Details on the items are displayed on the screen using the guide.

<table>
<thead>
<tr>
<th>Category</th>
<th>Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>📸 Camera</td>
<td>Photo (page 31)</td>
</tr>
<tr>
<td></td>
<td>Movie (page 31)</td>
</tr>
<tr>
<td>🎬 Viewer</td>
<td>Album (page 41)</td>
</tr>
<tr>
<td></td>
<td>Memory Stick (page 41)</td>
</tr>
<tr>
<td></td>
<td>Last Image (page 41)</td>
</tr>
<tr>
<td></td>
<td>Last Viewed (page 41)</td>
</tr>
<tr>
<td></td>
<td>Slide Show (page 42)</td>
</tr>
<tr>
<td>🎵 Music</td>
<td>Audio Player (page 102)</td>
</tr>
<tr>
<td>📞 Communication</td>
<td>Collaboration Shot (page 91)</td>
</tr>
<tr>
<td></td>
<td>Picture Gift (page 93)</td>
</tr>
<tr>
<td>🛠️ Toolbox</td>
<td>Print (page 98)</td>
</tr>
<tr>
<td></td>
<td>Share Images (page 95)</td>
</tr>
<tr>
<td>📁 Media Tools</td>
<td>General (page 56)</td>
</tr>
<tr>
<td></td>
<td>Media Space</td>
</tr>
<tr>
<td></td>
<td>Default Media</td>
</tr>
<tr>
<td></td>
<td>File Number</td>
</tr>
<tr>
<td></td>
<td>Check Album</td>
</tr>
<tr>
<td></td>
<td>Memory Stick (page 57)</td>
</tr>
<tr>
<td></td>
<td>Format</td>
</tr>
<tr>
<td></td>
<td>Create REC. Folder</td>
</tr>
<tr>
<td></td>
<td>Change REC. Folder</td>
</tr>
<tr>
<td></td>
<td>Internal Memory (page 59)</td>
</tr>
<tr>
<td></td>
<td>Scan Images</td>
</tr>
<tr>
<td></td>
<td>Format</td>
</tr>
<tr>
<td></td>
<td>Fully Format</td>
</tr>
<tr>
<td>Category</td>
<td>Items</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>📷 Settings</td>
<td>Main</td>
</tr>
<tr>
<td></td>
<td>Sound (page 61)</td>
</tr>
<tr>
<td></td>
<td>Beep</td>
</tr>
<tr>
<td></td>
<td>AVLS</td>
</tr>
<tr>
<td></td>
<td>Screen (page 62)</td>
</tr>
<tr>
<td></td>
<td>Language</td>
</tr>
<tr>
<td></td>
<td>HOME Design</td>
</tr>
<tr>
<td></td>
<td>Function Guide</td>
</tr>
<tr>
<td></td>
<td>LCD Brightness</td>
</tr>
<tr>
<td></td>
<td>Preferences (page 63)</td>
</tr>
<tr>
<td></td>
<td>Initialize</td>
</tr>
<tr>
<td></td>
<td>USB Connect</td>
</tr>
<tr>
<td></td>
<td>Video Out</td>
</tr>
<tr>
<td></td>
<td>Clock Set (page 65)</td>
</tr>
<tr>
<td></td>
<td>Clock Set</td>
</tr>
<tr>
<td></td>
<td>Camera (page 66)</td>
</tr>
<tr>
<td></td>
<td>Image Size(Photos)</td>
</tr>
<tr>
<td></td>
<td>Image Size(Movies)</td>
</tr>
<tr>
<td></td>
<td>AF Mode</td>
</tr>
<tr>
<td></td>
<td>Digital Zoom</td>
</tr>
<tr>
<td></td>
<td>Red Eye Reduction</td>
</tr>
<tr>
<td></td>
<td>AF Illuminator</td>
</tr>
<tr>
<td></td>
<td>SteadyShot</td>
</tr>
<tr>
<td></td>
<td>Auto Orientation</td>
</tr>
<tr>
<td></td>
<td>Music (page 69)</td>
</tr>
<tr>
<td></td>
<td>Repeat</td>
</tr>
<tr>
<td></td>
<td>MEGA BASS</td>
</tr>
<tr>
<td></td>
<td>LCD Auto Off</td>
</tr>
<tr>
<td></td>
<td>Network (page 70)</td>
</tr>
<tr>
<td></td>
<td>Access Point</td>
</tr>
<tr>
<td></td>
<td>Network Power Save</td>
</tr>
<tr>
<td></td>
<td>Nickname</td>
</tr>
<tr>
<td></td>
<td>Img exchg password</td>
</tr>
</tbody>
</table>
Using menu items

1 Press MENU to display the menu.
   • Different items are available depending on the mode.

2 Move the control button to ▲/▼ to select the menu item.

3 Move the control button to ◄/► to select a setting.
   • To display an item that is not displayed, move the control button to ◄/► until the item is displayed.

   Shooting mode | Playback mode

   • Press ● after selecting an item in playback mode.

4 Press MENU to turn off the menu.
Menu items

The available menu items vary depending on the mode position. Only the available items are displayed on the screen.

*(✓ : available)*

<table>
<thead>
<tr>
<th></th>
<th>Auto</th>
<th>Program</th>
<th>Scene Selection</th>
</tr>
</thead>
</table>

**Menu for shooting** *(page 34)*

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Camera</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Scene</td>
<td>—</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td>EV</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Focus</td>
<td>—</td>
<td>✓</td>
<td>—</td>
</tr>
<tr>
<td>Metering Mode</td>
<td>—</td>
<td>✓</td>
<td>—</td>
</tr>
<tr>
<td>White Bal</td>
<td>—</td>
<td>✓</td>
<td>✓*</td>
</tr>
<tr>
<td>ISO</td>
<td>—</td>
<td>✓</td>
<td>—</td>
</tr>
<tr>
<td>REC Mode</td>
<td>✓</td>
<td>✓</td>
<td>✓*</td>
</tr>
<tr>
<td>Flash Level</td>
<td>—</td>
<td>✓</td>
<td>—</td>
</tr>
<tr>
<td>Camera Set.</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

*The operation is limited according to the Scene Selection mode *(page 33).*

**Menu for viewing** *(page 45)*

- Album (Folder)
- Edit Image
- Find
- Slide Show
- Details
- Manage Images
- Label
- Print
- Import (Export)
Using the shooting functions

Changing the recording mode

Selects a camera mode on the menu screen.

**Still image shooting modes**

There are three shooting modes available for still images: auto, program, scene selection.

The default setting is [Auto].

To select camera modes other than [Auto], see the following procedure.

1. Press MENU.
2. Move the control button to ↑ to select [Camera].
3. Move the control button to ◀/▶ to select the desired mode.

**AUTO: Auto adjustment mode**

Allows easy shooting with the settings adjusted automatically.

**PGM: Program auto shooting mode**

Allows you to shoot with the exposure adjusted automatically (both the shutter speed and the aperture value). Also you can select various settings using the menu. (Refer to page 30 for details on the functions available.)

**SCN: Scene Selection mode (ISO  🌓  🌟  🌙  🌛  🌚  🌞  🌴  🌞  🌞  🌞)  🌚  🌚  🌚  🌚  🌚  🌚**

Allows you to shoot with preset settings according to the scene (page 32).

**To switch shooting modes**

Press HOME, and select [ ] (Camera) → [ ] (Photo) or [ ] (Movie) with the control button.

- You can perform this operation using the (Movie/Photo) button instead.
Shooting still images (Scene selection)

The following modes are predetermined to match the scene conditions.

- **High Sensitivity**
  Allows you to shoot images without a flash under low light conditions, reducing blur.

- **Hand-held Twilight**
  The camera performs multiple continuous shootings while compensating for camera-shake in order to capture an image. This function is useful when shooting a nightscape without a tripod.
  - The camera may not be able to fully compensate if the camera-shake is too strong, the subject is moving, or the image is too dark.

- **Twilight**
  Allows you to shoot night scenes at far distance without losing the dark atmosphere of the surroundings.

- **Twilight Portrait**
  Suitable for shooting portraits in dark places. Allows you to shoot sharp images of people in dark places without losing the dark atmosphere of the surroundings.

- **Soft Snap**
  Allows you to shoot skin colors in brighter and warmer tones for more beautiful pictures. In addition, the soft focus effect creates a gentle atmosphere for portraits of people, flowers, etc.

- **Landscape**
  Focuses only on a distant subject to shoot landscapes, etc.

- **Hi-Speed Shutter**
  Allows you to shoot moving subjects outdoors or in other bright places.
  - The shutter speed becomes faster, so images shot in dark places become darker.

- **Beach**
  When shooting seaside or lakeside scenes, the blue of the water is clearly recorded.

- **Snow**
  When shooting snowy scenes or other places where the whole screen appears white, use this mode to prevent sunken colors and record clear images.

- **Fireworks**
  Allows you to record fireworks in all their splendor.

*The shutter speed becomes slower, so using a tripod is recommended.*
Functions that cannot be combined with Scene Selection

For shooting an image appropriately according to the scene condition, a combination of functions is determined by the camera. Some functions are not available, depending on the Scene Selection mode.

(✓: you can select the desired setting)

<table>
<thead>
<tr>
<th>Scene Selection</th>
<th>Macro/Magnifying Glass</th>
<th>Flash</th>
<th>White Balance</th>
<th>Burst/Exposure Bracket</th>
<th>EV</th>
</tr>
</thead>
<tbody>
<tr>
<td>iSO</td>
<td>✓/—</td>
<td>§</td>
<td>✓*</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Night</td>
<td>—/—</td>
<td>§</td>
<td>—</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td>Night Shot</td>
<td>—/—</td>
<td>§</td>
<td>—</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td>Food</td>
<td>✓/—</td>
<td>§SL</td>
<td>—</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td>Portrait</td>
<td>✓/—</td>
<td>✓</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Panorama</td>
<td>—/—</td>
<td>§/§</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Landscape</td>
<td>✓/—</td>
<td>§/§</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Sports</td>
<td>✓/—</td>
<td>§/§</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Fireworks</td>
<td>—/—</td>
<td>§</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Beach</td>
<td>—/—</td>
<td>§</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

* [ § ] (Flash) cannot be selected.
The functions in shooting mode using the MENU button are described below. For details on how to operate the menu, see page 29.

The available modes are indicated as shown below. You cannot select the mode displayed in grey.

The default settings are marked with ✔.

**Camera: Selecting the still image camera mode**

See page 31.

**Scene: Selecting the Scene Selection mode**

See page 32.

**EV: Adjusting the exposure**

Manually adjusts the exposure.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>➖2.0EV</td>
<td>Toward –: Darkens an image.</td>
</tr>
<tr>
<td>✔0EV</td>
<td>The exposure is determined automatically by the camera.</td>
</tr>
<tr>
<td>➕2.0EV</td>
<td>Toward +: Brightens an image.</td>
</tr>
</tbody>
</table>

- The compensation value can be set in 1/3EV increments.
- If a subject is being shot in extremely bright or dark conditions, or the flash is used, the exposure adjustment may not be effective.
You can change the focus method. Use the menu when it is difficult to get the proper focus in auto focus mode.

<table>
<thead>
<tr>
<th>Focus Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /> (Multi AF)</td>
<td>Focuses on a subject in all ranges of the finder frame automatically.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Image" /> (Center AF) (Only for still image)</td>
<td>Focuses on a subject in the center of the finder frame automatically.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Image" /> (Spot AF) (Only for still image)</td>
<td>Focuses on an extremely small subject or a narrow area automatically.</td>
</tr>
<tr>
<td>0.5m</td>
<td>Focuses on the subject using a previously set distance to the subject. (Focus preset)</td>
</tr>
<tr>
<td>1.0m</td>
<td></td>
</tr>
<tr>
<td>3.0m</td>
<td></td>
</tr>
<tr>
<td>7.0m</td>
<td></td>
</tr>
<tr>
<td>∞ (unlimited distance)</td>
<td></td>
</tr>
</tbody>
</table>

- This mode is useful when the subject is not in the center of the frame.
- Using together with the AF lock function lets you shoot in the desired image composition.
- Using together with the AF lock function lets you shoot in the desired image composition. Hold the camera steady not to misalign the subject and the AF range finder frame.
- When shooting a subject through a net or through window glass, it is difficult to get the proper focus in auto focus mode. In these cases, use of Focus preset is convenient.
• AF stands for Auto Focus.
• Distance setting information in Focus preset is approximate. If you point the lens up or down, the error increases.
• When you use Digital Zoom or AF Illuminator, the setting of the AF range finder frame becomes unavailable and the frame is indicated with a dotted line. Priority AF movement is given to subjects in or near the center of the frame.

防空 If the subject is out of focus
When shooting with the subject at the edge of the frame (or the screen), or when using [ ] (Center AF) or [ ] (Spot AF), the camera may not focus on a subject at the edge of the frame.

In such cases, do as follows.

① Recompose the shot so that the subject is centered in the AF range finder, and press the shutter button halfway down to focus on the subject (AF lock).

② When the AE/AF lock indicator stops flashing and remains on, return to the fully composed shot, and press the shutter button fully down.
Using the shooting functions

Metering Mode: Selecting the metering mode

Selects the metering mode that sets which part of the subject to measure to determine the exposure.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️ (Multi)</td>
<td>Divides into multiple regions and measures each region. The camera determines a well-balanced exposure (Multi-pattern metering).</td>
</tr>
<tr>
<td>⊗ (Center)</td>
<td>Measures the center of the image, and determines the exposure based on the brightness of the subject there (Center-weighted metering).</td>
</tr>
<tr>
<td>⊗ (Spot) (Only for still image)</td>
<td>Measures only a part of the subject (Spot metering). - This function is useful when the subject is backlit or when there is strong contrast between the subject and the background.</td>
</tr>
</tbody>
</table>

- When using spot metering or center-weighted metering, setting [Focus] to [ ⊗ ] (Center AF) is recommended to focus on the metering position (page 35).

White Bal: Adjusting the color tones

Adjusts the color tones according to the lighting condition in a situation, for example, when the colors of an image look strange.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️ AUTO (Auto)</td>
<td>Adjusts the White Balance automatically.</td>
</tr>
<tr>
<td>☀️ (Daylight)</td>
<td>Adjusts for outdoors conditions on a fine day, evening views, night scenes, neon signs, fireworks, etc.</td>
</tr>
<tr>
<td>☁️ (Cloudy)</td>
<td>Adjusts for a cloudy sky or shadow areas.</td>
</tr>
</tbody>
</table>
### Shooting menu

**For details on the operation page 29**

<table>
<thead>
<tr>
<th>(Fluorescent)</th>
<th>Adjusts for fluorescent lighting.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Fluorescent" /></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>(Incandescent)</th>
<th>Adjusts for incandescent lighting or video light such as at photography studios.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Incandescent" /></td>
<td></td>
</tr>
</tbody>
</table>

| (Flash) | Adjusts for the flash conditions.  
• You cannot select this item when shooting movies. |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Flash" /></td>
<td></td>
</tr>
</tbody>
</table>

- Under fluorescent lights that flicker, the white balance function may not work correctly even though you select [ (Fluorescent)].
- Except in [ (Flash) modes, [White Bal] is set to [AUTO] (Auto) when the flash strobes.
- Some options are not available depending on the Scene Selection mode (page 33).

### ISO: Selecting a luminous sensitivity

**AUTO**  
**PGM**  
**SCN**  
**M**

<table>
<thead>
<tr>
<th>Small number</th>
<th>Large number</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Small number" /></td>
<td><img src="image" alt="Large number" /></td>
</tr>
</tbody>
</table>

Selects a luminous sensitivity with units of ISO. The larger the number, the higher the sensitivity.
Using the shooting functions

Shooting menu

For details on the operation page 29

- Note that the image tends to become noisier as the ISO sensitivity number increases.
- [ISO] is set to [AUTO] (Auto) in the Scene Selection mode.
- When shooting under brighter conditions, the camera automatically increases its tone reproduction and helps prevent images to become whitish (excluding when [ISO] is set to [ISO 80]).

**ISO**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUTO (Auto)</td>
<td>Select a large number when shooting in dark locations or shooting a subject moving at high speed, or select a small number to obtain high image quality.</td>
</tr>
<tr>
<td>ISO 80</td>
<td></td>
</tr>
<tr>
<td>ISO 100</td>
<td></td>
</tr>
<tr>
<td>ISO 200</td>
<td></td>
</tr>
<tr>
<td>ISO 400</td>
<td></td>
</tr>
<tr>
<td>ISO 800</td>
<td></td>
</tr>
<tr>
<td>ISO 1000</td>
<td></td>
</tr>
</tbody>
</table>

**REC Mode: Selecting the continuous shooting method**

Selects whether the camera performs continuous shooting or not when you press the shutter button.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Normal)</td>
<td>Does not shoot continuously.</td>
</tr>
<tr>
<td>(Burst)</td>
<td>Records the maximum number of images in succession (refer to the following table) when you press and hold down the shutter button.</td>
</tr>
<tr>
<td></td>
<td>• When “Recording...” disappears, you can shoot the next image.</td>
</tr>
<tr>
<td></td>
<td>• The flash is set to (Flash forced off).</td>
</tr>
<tr>
<td>BRK ±0.3EV (BRK ±0.3EV)</td>
<td>Records a series of three images with the exposure values automatically shifted (Exposure Bracket). The larger the bracket step value, the larger the shift of the exposure value.</td>
</tr>
<tr>
<td>BRK ±0.7EV (BRK ±0.7EV)</td>
<td></td>
</tr>
<tr>
<td>BRK ±1.0EV (BRK ±1.0EV)</td>
<td></td>
</tr>
</tbody>
</table>

- When [Camera] is set to [AUTO], you cannot use Exposure Bracket.
- The flash is set to (Flash forced off).
On the Burst
• When recording with the self timer, a series of a maximum of seven images is recorded.
• The recording interval is approximately 0.3 second.
• When the battery level is low, or when the internal memory or “Memory Stick Duo” is full, the Burst stops.
• You may not be able to shoot images in the Burst mode depending on the Scene Selection mode (page 33).

The maximum number of continuous shots

<table>
<thead>
<tr>
<th>Size</th>
<th>The number of images</th>
</tr>
</thead>
<tbody>
<tr>
<td>6M</td>
<td>7</td>
</tr>
<tr>
<td>3:2</td>
<td>7</td>
</tr>
<tr>
<td>3M</td>
<td>10</td>
</tr>
<tr>
<td>2M</td>
<td>15</td>
</tr>
<tr>
<td>VGA</td>
<td>100</td>
</tr>
<tr>
<td>16:9</td>
<td>15</td>
</tr>
</tbody>
</table>

On the Exposure Bracket
• The focus and white balance are adjusted for the first image, and these settings are also used for the other images.
• When the exposure is manually adjusted (page 34), the exposure is shifted based on the adjusted brightness.
• The recording interval is approximately 0.3 second.
• If the subject is too bright or too dark, you may be unable to shoot properly with the selected bracket step value.
• You may not be able to shoot images in the Exposure Bracket mode depending on the Scene Selection mode (page 33).

Flash Level: Adjusting the amount of flash light

Adjusts the amount of flash light.

<table>
<thead>
<tr>
<th>Flash Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>– (–)</td>
<td>Toward –: Makes the flash level lower.</td>
</tr>
<tr>
<td>☑  $ (Normal)</td>
<td></td>
</tr>
<tr>
<td>+ (+)</td>
<td>Toward +: Makes the flash level higher.</td>
</tr>
</tbody>
</table>

• To change flash mode, see page 20.

Camera Set.: Changing setup items for shooting

You can set up the recording functions. This item is the same as the [ Camera] item in [ Settings] via the home screen. For details, see page 66.
Using the playback functions

Playing back images from the home screen

You can easily select a playback image from the home screen.

1. Press HOME.
2. Select [ ] (Viewer) by moving the control button to ←/→.
3. Select the desired item by moving the control button to ↑/↓, then press ●.

**Album**
Displays Album Images on the index screen.

**Memory Stick**
Displays images stored in the “Memory Stick Duo” on the folder selection screen.

**Last Image**
Displays the last recorded image. This is the same function as that of the ▶ (Playback) button.

- Images that were imported, recorded by another camera, or shot with Collaboration Shot are not displayed even if these dates are the latest.

**Last Viewed**
Displays the last viewed Album Image.
Playing back images from the home screen

Slide Show

1. Select [Slide Show] from the home screen.
2. When playing back Album Images, select [Album] with the control button first, or when playing back images stored in a “Memory Stick Duo”, select [Memory Stick] first, and then press .

3. Select and set up each item with the control button.
4. Select [Start], then press . 
   The slide show starts.
   If you do not want to start the slide show immediately, select [Exit], then press .

To pause the slide show
Press .
To restart, select [Continue], then press .
- The slide show resumes from the image which was paused, however, the music starts again from the beginning.

To display the previous/next image
Move the control button to →/←.

To adjust the volume of the music
Move the control button to ↑/↓ to adjust the volume.

To end the slide show
Press . or select [Exit], then press the .

To change the setup
The default settings are marked with ✓.

<table>
<thead>
<tr>
<th>Select Images</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Plays back all the images.</td>
</tr>
<tr>
<td>✓ Whole Album (All In This Folder)</td>
<td>Plays back all the images in the selected album (or folder).</td>
</tr>
<tr>
<td>Multiple Image</td>
<td>Plays back the selected images (page 24).</td>
</tr>
</tbody>
</table>
### Playing back images from the home screen

#### Effects

<table>
<thead>
<tr>
<th>Effect</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple</td>
<td>A simple slide show suitable for a wide range of scenes.</td>
</tr>
<tr>
<td>Nostalgic</td>
<td>A moody slide show reproducing the atmosphere of a movie scene.</td>
</tr>
<tr>
<td>Stylish</td>
<td>A stylish slide show proceeding at a middle tempo.</td>
</tr>
<tr>
<td>Active</td>
<td>A high-tempo slide show suitable for active scenes.</td>
</tr>
<tr>
<td>Normal</td>
<td>A basic slide show switching images at a predetermined interval.</td>
</tr>
</tbody>
</table>

- When set to [Simple], [Nostalgic], [Stylish] or [Active], only still images are displayed.
- Music is not played (set to [Off]) during a [Normal] slide show. The sound of movies will be heard.

#### Music

The preset-Music differs depending on the effect you select.

<table>
<thead>
<tr>
<th>Music</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Music 1</td>
<td>The default setting for a [Simple] slide show.</td>
</tr>
<tr>
<td>Music 2</td>
<td>The default setting for a [Nostalgic] slide show.</td>
</tr>
<tr>
<td>Music 3</td>
<td>The default setting for a [Stylish] slide show.</td>
</tr>
<tr>
<td>Music 4</td>
<td>The default setting for a [Active] slide show.</td>
</tr>
<tr>
<td>My Group</td>
<td>A folder inside the “MUSIC” folder is selected, and the tracks in the folder are played in sequence.</td>
</tr>
<tr>
<td>My Music</td>
<td>The list of tracks in the “MUSIC” folder is displayed, and the selected track is played when performing a slideshow.</td>
</tr>
<tr>
<td>Off</td>
<td>Setting for a [Normal] slide show. No Music available.</td>
</tr>
</tbody>
</table>

#### Interval

<table>
<thead>
<tr>
<th>Interval</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
<td>The interval is set to suit the selected [Effects] item.</td>
</tr>
<tr>
<td></td>
<td>The setting is fixed to [Auto] when [Effects] is not set to [Normal].</td>
</tr>
<tr>
<td>3 sec</td>
<td>Sets the display interval of images for a [Normal] slide show.</td>
</tr>
<tr>
<td>5 sec</td>
<td></td>
</tr>
<tr>
<td>10 sec</td>
<td></td>
</tr>
<tr>
<td>30 sec</td>
<td></td>
</tr>
<tr>
<td>1 min</td>
<td></td>
</tr>
</tbody>
</table>
Playing back images from the home screen

<table>
<thead>
<tr>
<th>Play Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️ Repeat</td>
<td>The slideshow is repeated in sequence.</td>
</tr>
<tr>
<td>Random</td>
<td>The images are shown at random in the slideshow.</td>
</tr>
<tr>
<td>Normal</td>
<td>The slideshow is performed once in sequence.</td>
</tr>
</tbody>
</table>

💡 To import music files to the “MUSIC” folder in the camera
You can import an MP3 file to the “MUSIC” folder in the camera using a computer.
For details, see page 101.
The functions available in playback mode using the MENU button are described below. For details on how to operate the menu, see page 29.

### Album/ Folder: Go To Album/Go To Folder, Combine Album, Split Album

You can search for an album in chronological order, or combine or split the album created in the camera.

- When playing images stored in the “Memory Stick Duo”, only (Go To Folder) is displayed.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Go To Album)</td>
<td>Selects and goes to another album (folder).</td>
</tr>
<tr>
<td>(Go To Folder)</td>
<td>Selects and goes to another folder.</td>
</tr>
<tr>
<td>(Combine Album)</td>
<td>Combines two albums into one.</td>
</tr>
<tr>
<td>(Split Album)</td>
<td>Splits an album in two at the desired point.</td>
</tr>
</tbody>
</table>

#### To go to another album

1. Select [ ] (Go To Album) with the control button, then press . The album list appears.

   - In each album, the oldest image in an album is displayed.
   - Moving the control button to displays an album created around the same time in the last or next year.
   - The name of an album is in date format. If you use the “Album Editor” in the CD-ROM (supplied), you can change the date format name to alphabetical characters name (page 78).

2. Select the desired album, then press . The selected album is displayed.

#### To go to another folder

1. Select [ ] (Go To Folder) with the control button, then press . The folder list appears.

   - In each folder, the oldest image in a folder is displayed.

2. Select the folder, then press . The selected folder is displayed.
To combine two albums into one

1. Display an image in the source album.
2. Select [)” (Combine Album) with the control button, then press ●. The album selection screen appears.
3. Select the destination album by moving the control button to ↑/↓, then press ●.
4. Select [OK], then press ●. The two albums are combined into one.

- The source album is deleted.
- If you combine albums when the image is narrowed down, only the images that fit the search condition will move to the destination album.

To cancel the combination

Press BACK.

To split an album into two

1. Display an image in the album you want to split.
2. Select [)” (Split Album) with the control button, then press ●. The album split screen appears.
3. Select the split spot by moving the control button to ←/→, then press ●.
4. Select [OK], then press ●. The album is split into two at the specified spot.

To cancel the split

Press BACK.
The name of the first half of the split album is the same as that of the original album and the name of the last half becomes "original name - (2)".

If you select [ ] (Split Album) while refining your search, the search is canceled.

---

**Manage Images: Delete, Protect**

Deletes images, or protects images against accidental erasure.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Delete: Multiple Images)</td>
<td>Selects and deletes images.</td>
</tr>
<tr>
<td>(Delete: This Image)</td>
<td>Deletes the image that is currently selected.</td>
</tr>
<tr>
<td>(Protect: Multiple Images)</td>
<td>Selects and protects/unlocks images.</td>
</tr>
<tr>
<td>(Protect: This Image)</td>
<td>Protects/unlocks the image that is currently selected.</td>
</tr>
</tbody>
</table>

**To select and delete images**

1. Select [ ] (Delete: Multiple Images) with the control button, then press .
   The image selection screen appears.
2. Select the images (page 24).
3. Press MENU to display the menu.
4. Select [OK], then press .
5. While viewing Album Images, select [Original Image Only] or [Original & Album Images], then press .
   The selected images are deleted.

**To delete an image**

1. Select the image.
2. Select [ ] (Delete: This Image) with the control button, then press .
3. While viewing Album Images, select [Original Image Only] or [Original & Album Images], then press .
   The image is deleted.

* You can delete images using the / button instead. When the single screen is displayed, the option is fixed to [This Image], and the index screen is displayed, it is fixed to [Multiple Images].

**To select and protect images**

1. Select [ ] (Protect: Multiple Images) with the control button, then press .
   The image selection screen appears.
2. Select the images (page 24).
3. Press MENU to display the menu.
4. Select [OK], then press .
   The selected images are protected and the (protect) indicator appears on the lower of the LCD screen.
To protect an image

1. Select the image.
2. Select [Protect] (Protect: This Image) with the control button, then press .
   The image is protected and the (protect) indicator appears on the lower of the LCD screen.

To cancel the protection

Follow the process for protection, select the images you want to cancel their protection, then press .

- Note that the formatting erases all the data stored on the recording media, even if the images are protected, and these images cannot be restored.
- It may take some time to protect an image.

Edit Image: Rotate, Resize

Rotates an image, or changes the image size.

<table>
<thead>
<tr>
<th>Rotate (Rotate)</th>
<th>Rotates a still image clockwise or counterclockwise.</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Image before rotation]</td>
<td>![Image after rotation]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Resize (Resize)</th>
<th>You can change the image size of a recorded image (Resize), and save it as a new file. The Original Image is retained even after resizing.</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Image before resizing]</td>
<td>![Image after resizing] Large size Small size</td>
</tr>
</tbody>
</table>

To rotate an image

1. Select the image.
2. Select [Rotate] (Rotate) with the control button, then press .
3. Select [← →], then rotate the image by moving the control button to ←/→.
4. Select [OK], then press .

To cancel rotation

In step 3 or 4, select [Exit], then press .

- You cannot rotate protected images or movies.
- You may not be able to rotate images shot with other cameras.
• When viewing images on a computer, the image rotation information may not be reflected, depending on the software.

To change the image size of a recorded image

1. Select the image.
2. Select [ ] (Resize) with the control button, then press •.
3. Select the desired size, then press •.
   - Select from [6M], [3M], [2M], or [VGA].
   - The resized image is recorded in the selected album (recording folder) as the newest file.

To cancel resize

In step 3, select [Exit], then press •.

• For details on guidelines for selecting the image size, see page 22.
• You cannot change the size of movies.
• When there is the Original Image, the Original Image is resized, and when there is not the Original Image, its Album Image is resized.
• When you change from a small size to a large size, the image quality deteriorates.
• You cannot resize to an image size of 3:2 or 16:9.

Label: Add Label, No Label

You can label images.

• The following labels are provided with the camera. The provided labels are as follows:
  Favorites/Wedding/Birthday/Party/Kids/Family/Friends/Sports/Travel/Scenery/Pets/Pastimes/Other
  If you use the application (supplied), you can edit the label.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Add Label: Multiple Images)</td>
<td>Selects and labels images.</td>
</tr>
<tr>
<td>(Add Label: This Image)</td>
<td>Labels the image that is currently selected.</td>
</tr>
<tr>
<td>(No Label: Multiple Images)</td>
<td>Selects images and detaches their labels.</td>
</tr>
<tr>
<td>(No Label: This Image)</td>
<td>Detaches the label from the image that is currently selected.</td>
</tr>
</tbody>
</table>

To select and label images

1. Select [ ] (Add Label: Multiple Images) with the control button, then press •.
   - The label selection screen appears.
② Select the desired label by moving the control button to ↑/↓, then press ●.
The image selection screen appears.

③ Select the images (page 24).
④ Press MENU to display the menu.
⑤ Select [OK], then press ●.
The selected label is registered on the images, and ● is indicated on the lower portion of the screen.

To label an image
① Select the image.
② Select [ ] (Add Label: This Image) with the control button, then press ●.
The label selection screen appears.

③ Select the desired label by moving the control button to ↑/↓, then press ●.
The selected label is registered on the image, and ● is indicated on the lower portion of the screen.

To detach the label from multiple images
① Select [ ] (No Label: Multiple Images) with the control button, then press ●.
The label selection screen appears.
② Select the desired label by moving the control button to ↑/↓, then press ●.
The image selection screen appears.
③ Select the images (page 24).
④ Press MENU to display the menu.
⑤ Select [OK], then press ●.
The selected label is detached from the images, and ● disappears from the lower portion of the screen.

To detach the label from an image
① Select the image.
② Select [ ] (No Label: This Image) with the control button, then press ●.
The label selection screen appears.
Select the desired label by moving the control button to \(\uparrow/\downarrow\), then press \(\bullet\). When you detach all the labels from the image, select [All Labels], then press \(\bullet\).

The selected label is detached from the image, and \(\circlearrowright\) disappears from the lower portion of the screen.

### Find: Keyword, Similar Images

Searches for images.

<table>
<thead>
<tr>
<th>(Keyword)</th>
<th>Searches for images in albums (internal memory) by keywords.</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Keyword Off)</td>
<td>Clears the image search keyword.</td>
</tr>
<tr>
<td>(Similar Images)</td>
<td>Searches for images similar to the selected image. This search targets images that have been analyzed with “Album Editor” in the CD-ROM (supplied).</td>
</tr>
</tbody>
</table>

#### To narrow your search

1. Select [Keys] (Keyword) with the control button, then press \(\bullet\).

The screen used for selecting a keyword item appears.

![Screen used for selecting a keyword item](image)

2. Select the keyword item by moving the control button to \(\leftarrow/\rightarrow\), and select the condition by moving it to \(\uparrow/\downarrow\), then press \(\bullet\).

The selected conditions are indicated in the frame located on the left side.

- **Label**: Narrow your search by the label attached with [Add Label].
- **Face Detection**: Narrow your search based on whether a person/persons appear(s) in the photo or not.
- **Color Detection**: Narrow your search by the color: [Dark Image], [Light Image], [Reddish Image], [Bluish Image], [Greenish Image], [Yellowish Image].
- **Properties**: Narrow your search by the properties, for example, whether the protection is set to on.

* This search targets images that have been analyzed with “Album Editor” in the CD-ROM (supplied).

3. Press MENU.

The menu appears.

4. Select [AND] or [OR], then press \(\bullet\).

**AND**: Images for which all the conditions are met.

**OR**: Images for which either of the conditions is met.

5. Select [OK], then press \(\bullet\).

The images that meet the condition are displayed.
To cancel the search
In Step 5, select [Exit], then press •.

To clear all the conditions
In Step 5, select [Clear All], then press •.

To search the images similar to an image
① Select the image.
② Select [ ] (Similar Images) with the control button, then press •.

The images similar to the Original Image are searched and displayed in the order of similarity.

Print

Prints still images.

<table>
<thead>
<tr>
<th>(Print: Multiple Images)</th>
<th>Selects and prints images.</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Print: This Image)</td>
<td>Prints the image that is currently selected.</td>
</tr>
</tbody>
</table>

For details on print, see page 98.

Slide Show

This item has the same function as the [Slide Show] on the home screen. See page 42.

Import/Export

Copies the images stored in the “Memory Stick Duo” to an album (Import) and copies the Album Images to the “Memory Stick Duo” (Export).

<table>
<thead>
<tr>
<th>(Import: Multiple Images)</th>
<th>Selects images and copies the images from the “Memory Stick Duo” to the internal memory.</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Import: This Image)</td>
<td>Copies the image that is currently selected from the “Memory Stick Duo” to the internal memory.</td>
</tr>
<tr>
<td>(Export: Multiple Images)</td>
<td>Selects images and copies the images from the internal memory to the “Memory Stick Duo”.</td>
</tr>
<tr>
<td>(Export: This Image)</td>
<td>Copies the image that is currently selected from the internal memory to the “Memory Stick Duo”.</td>
</tr>
</tbody>
</table>

• If its image size is over 6 M, you cannot view the image on the camera, which was copied to the camera. You can resize images using the “Album Editor”.
• When an Original Image is stored, the Original Image is exported, and when not stored, its Album Image is exported.
To select and copy images

1. Select [ ] (Import: Multiple Images) or [ ] (Export: Multiple Images) with the control button, then press .
2. Select the images (page 24).
3. Press MENU to display the menu.
4. Select [OK], then press .
   The selected images are copied.

To copy an image

1. Select the image.
2. Select [ ] (Import: This Image) or [ ] (Export: This Image) with the control button, then press .
   The image is copied.

Details

Displays the detailed data on the selected image.
How to change the settings

You can change the default settings using [Media Tools] or [Settings] via the home screen.

1. Press HOME to display the home screen.

2. Select [Media Tools] or [Settings] by moving the control button to ⏩/⏪.

3. Select the desired item by moving the control button to ⬆️/⬇️, then press ●.
   - When [Main] in [Settings] is selected, select [Sound], [Screen], or [Preferences] by moving the control button to ⬆️/⬇️.

4. Select the item selection area by moving the control button to ⏯, and select the desired item by moving the control button to ⬆️/⬇️, then press ●.
5 Select the desired setting by moving the control button to ↑/↓, then press ●.

To cancel the setup
When there is [Cancel] in the settings, select [Cancel], then press ●. When there is not [Cancel], set up again.

• These settings are maintained even when the power is turned off.
The default settings are marked with ✔.

### Media Space
Displays the free space available on the media.

### File Number
Selects the method used to assign file numbers to images.

<table>
<thead>
<tr>
<th>✔ Series</th>
<th>Assigns numbers to files in sequence even if the recording folder or the “Memory Stick Duo” is changed. (When the replaced “Memory Stick Duo” contains a file with a number higher than the last assigned number, a number one higher than the largest number is assigned.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset</td>
<td>Starts from 0001 each time the folder is changed. (When the recording folder contains a file, a number one higher than the largest number is assigned.)</td>
</tr>
</tbody>
</table>

### Default Media
Assigns the priority media for recording Original Images when a “Memory Stick Duo” is inserted.

| ✔ Memory Stick | Records in the “Memory Stick Duo”. |
| Internal Memory | Records in the internal memory. |

### Check Album
Restores the database if the album is not displayed correctly.

- Use a fully charged battery pack or the AC Adaptor with the camera installed on the Cyber-shot Station.
  1. Select [Check Album] with the control button, then press ●. The message “Recover data” appears.
  2. Select [OK], then press ●. Album check starts.

**To cancel the album check**
Select [Cancel] in step 2, then press ●.
Memory Stick

Format

Formats the “Memory Stick Duo”. A commercially available “Memory Stick Duo” is already formatted, and can be used immediately.

- Note that formatting irrevocably erases all data on a “Memory Stick Duo”, including even protected images.

1. Select [Format] with the control button, then press .
   The message “All data on Memory Stick will be erased” appears.

2. Select [OK], then press .
   The format is complete.

To cancel the formatting

Select [Cancel] in step 2, then press .

Create REC. Folder

Creates a folder in a “Memory Stick Duo” for recording images.

1. Select [Create REC. Folder] with the control button, then press .
   The message “Creating REC. folder” appears.

2. Select [OK], then press .
   A new folder is created with a number incremented one higher than the largest number, and the folder becomes the current recording folder.

To cancel the folder creation

Select [Cancel] in step 2, then press .

- When not creating a new folder, the “101” folder is selected as the recording folder.
- You can create folders designated up to “999.”
- Images are recorded in the newly created folder until a different folder is created or selected.
- You cannot delete a folder with the camera. To delete a folder, use your computer, etc.
- Up to 4,000 images can be stored in one folder. When the folder capacity is exceeded, a new folder is automatically created.
- For details, see “Image file storage destinations and file names” (page 87).
Changes the folder currently used for recording images.

1. Select [Change REC. Folder] on the control button, then press ●.
   The folder selection screen appears.

2. Select the desired folder by moving the control button to ie/ê.
3. Select [OK], then press ●.

**To cancel changing the recording folder**
Select [Cancel] in step 2 or 3, then press ●.

- You cannot select the “100” folder as a recording folder.
- You cannot move recorded images to a different folder.
Internal Memory

Scan Images

Scans the images that have been copied directly, using the Mass Storage connection, to the internal memory without “Album Editor” (supplied), and displays these images in an album.

- Use a fully charged battery pack or the AC Adaptor with the camera installed on the Cyber-shot Station. If you attempt to copy image files using a battery pack with little remaining charge, the battery pack may run out, causing copying to fail or possibly corrupting the data.

1. Select [Scan Images] on the control button, then press ●. The message “Add unregistered images?” appears.
2. Select [OK], then press ●. Copying starts.

To cancel the copying
Select [Cancel] in step 2, then press ●.

Format

Formats the management area in the internal memory to the factory default. All data, such as the stored images, albums, music files, are erased.

- Note that formatting irrevocably erases all data in the internal memory, including even protected images. You can restore these images later if you have backed up the images using the “Album Editor”.

1. Select [Format] with the control button, then press ●. The message “All data in internal memory will be erased” appears.
2. Select [OK], then press ●. The format is complete.

To cancel the formatting
Select [Cancel] in step 2, then press ●.
Erases (initializes) all the data in the internal memory completely. [Format] may not erase the data in the internal memory. [Fully Format] is recommended when you discard or transfer the camera.

- Use a fully charged battery pack or the AC Adaptor with the camera installed on the Cyber-shot Station.
- Note that formatting irrevocably erases all data in the internal memory, including even protected images.

1. Select [Fully Format] with the control button, then press .
   The message “All data in internal memory will be erased” appears.

2. Select [OK], then press .
   The format is complete.

**To cancel the formatting**
Select [Cancel] in step 2, then press .

- It may take several minutes to do this operation.
Main – Sound

The default settings are marked with ✔.

Beep

Selects the sound produced when you operate the camera.

<table>
<thead>
<tr>
<th>Shutter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ On</td>
<td>Turns on the beep/shutter sound when you press the control button/press the shutter button.</td>
</tr>
<tr>
<td>Off</td>
<td>Turns off the beep/shutter sound.</td>
</tr>
</tbody>
</table>

AVLS

This function holds down the maximum volume to reduce a feeling of oppression. This is convenient when you prevent the sound from leaking out of the headphones.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ Off</td>
<td>Holds down the maximum volume.</td>
</tr>
<tr>
<td>On</td>
<td>Does not use the AVLS function.</td>
</tr>
</tbody>
</table>

• “AVLS” is an abbreviation of “Automatic Volume Limiter System”.

For details on the operation page 54
## Main – Screen

The default settings are marked with ✓.

### Language

Selects the language used for display.

### HOME Design

Selects the home screen design.

| ✓ Design 1 | Sets the background color of the home screen to black. |
| Design 2 | Sets the background color of the home screen to white. |

### Function Guide

When you operate the camera, the description of functions is displayed.

| ✓ On | Displays the function guide. |
| Off | Does not display the function guide. |

### LCD Brightness

Selects the brightness of the LCD backlight (only when the camera is used with the battery pack).

| Bright | Brightens. |
| ✓ Normal | |

- You can change the setting by pressing DISP (Screen display switch) button longer.
- Selecting [Bright] uses up the battery pack charge faster.
Changing the settings

**Main – Preferences**

The default settings are marked with ✚.

**Initialize**

Initializes all settings.

① Select [Initialize] with the control button, then press •. The message “Initialize all settings” appears.

② Select [OK], then press •.

Initialize is complete.

**To cancel the initializing**

Select [Cancel] in step ②, then press •.

- Be careful not to get the camera be turned off.

**USB Connect**

Selects the USB mode to be used when connecting the camera to a computer or a PictBridge compliant printer using the USB cable.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PictBridge</td>
<td>Connects the camera to a PictBridge compliant printer (page 98).</td>
</tr>
<tr>
<td>Mass Storage</td>
<td>Establishes a Mass Storage connection between the camera and a computer or other USB device (page 86).</td>
</tr>
<tr>
<td>✚ Auto</td>
<td>The camera recognizes automatically and sets up communication with a computer or PictBridge compliant printer (pages 86 and 98).</td>
</tr>
<tr>
<td></td>
<td>• If the camera and a PictBridge compliant printer cannot be connected when set to [Auto], change the setting to [PictBridge].</td>
</tr>
<tr>
<td></td>
<td>• If the camera and a computer or other USB device cannot be connected when set to [Auto], change the setting to [Mass Storage].</td>
</tr>
</tbody>
</table>
Video Out

Sets the video signal output according to the TV color system of the connected video equipment. Different countries and regions use different TV color systems. If you want to view images on a TV screen, check page 74 for the TV color system of the country or region where the camera is used.

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC</td>
<td>Sets the video output signal to NTSC mode (e.g., for the USA, Japan).</td>
</tr>
<tr>
<td>PAL</td>
<td>Sets the video output signal to PAL mode (e.g., for Europe).</td>
</tr>
</tbody>
</table>
Clock Set

Clock Set

Sets the date and time.

1. Select and set up [Area] with the control button.
2. Select and set up [Daylight Savings] with the control button.
3. Select and set up [Date display order] with the control button.
4. Set the date and time.
5. Select [OK] with the control button, then press \( \text{OK} \).

**To cancel the clock setting**

Select [Cancel], then press \( \text{OK} \).

- For details on the “World time difference”, see page 119.
**Camera**

The default settings are marked with ✔.

### Image Size(Photos)

Specifies the number of pixels for still images.

<table>
<thead>
<tr>
<th>✔ 6M</th>
<th>The  / (Image Size) button is also available for this item operation. See page 22.</th>
</tr>
</thead>
<tbody>
<tr>
<td>3:2</td>
<td></td>
</tr>
<tr>
<td>3M</td>
<td></td>
</tr>
<tr>
<td>2M</td>
<td></td>
</tr>
<tr>
<td>VGA</td>
<td></td>
</tr>
<tr>
<td>16:9</td>
<td></td>
</tr>
</tbody>
</table>

### Image Size(Movies)

Specifies the number of pixels for movies.

| ✔ 640×480 | The  / (Image Size) button is also available for this item operation. See page 22. |
| 320×240 |

### AF Mode

Selects the auto focus operation mode.

| ✔ Single | Automatically adjusts the focus when the shutter button is pressed and held halfway down. This mode is useful for shooting stationary subjects. |
| Monitor | Automatically adjusts the focus before the shutter button is pressed and held halfway down. This mode shortens the time needed for focusing.  
- Battery consumption is faster than in [Single] mode. |
Digital Zoom

Selects the digital zoom mode. The camera enlarges the image using optical zoom (up to 3×). When the zoom scale exceeds 3×, the camera uses digital zoom.

| On     | Enlarges all image sizes up to a maximum of 6×, but the image quality deteriorates. |
| Off    | Does not use the digital zoom. |

- When you press the zoom button, the zoom scaling indicator appears as follows.

- The maximum zoom scale of digital zoom includes the scale of the optical zoom.
- The setting of the AF range finder frame becomes unavailable and the frame is indicated with a dotted line. AF operates with priority on subjects located near the center of the frame.

Red Eye Reduction

Reduces the red-eye phenomenon when using the flash. Select this before shooting.

| On     | Reduces the red-eye phenomenon.  
|        | - The flash pre-strobes twice before shooting. |
| ✔ Off   | Does not use Red Eye Reduction. |

- Because it takes about a second until the shutter clicks, hold the camera firmly to prevent the effects of vibration. Also, do not let the subject move.
- Red-eye reduction may not produce the desired effects depending on individual differences, the distance to the subject, if the subject does not see the pre-strobe, or other conditions.

AF Illuminator

The AF illuminator supplies fill light to focus more easily on a subject in dark surroundings. The AF illuminator emits red light allowing the camera to focus easily when the shutter button is pressed halfway, until the focus is locked. The \( \text{CON} \) indicator appears at this time.

| ✔ Auto     | Uses the AF illuminator. |
| Off        | Does not use AF illuminator. |
• If the AF illuminator light does not reach the subject sufficiently or the subject has no contrast, focus will not be achieved. (A distance of up to approximately 2.7 m (8 feet 10 3/8 inches) (zoom: W) / 2.5 m (8 feet 2 1/2 inches) (zoom: T) is recommended.)

• Focus is achieved as long as the AF illuminator light reaches the subject, even if the light is slightly off the center of the subject.

• When Focus preset is set (page 35), AF Illuminator does not function.

• The setting of the AF range finder frame becomes unavailable and the frame is indicated with a dotted line. AF operates with priority on subjects located near the center of the frame.

• The AF illuminator does not operate when  (Hand-held Twilight mode),  (Twilight mode),  (Landscape mode),  (Hi-Speed Shutter mode) or  (Fireworks mode) is selected in the Scene Selection mode.

• The AF illuminator emits very bright light. Although there are no problems with safety, do not look directly into the AF illuminator emitter at close range.

### SteadyShot

Selects the anti-blur mode.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️ Shooting</td>
<td>Activates the anti-blur function when pressing the shutter button halfway down.</td>
</tr>
</tbody>
</table>
| Continuous | Always activates the anti-blur function. You can stabilize images even when zooming up a far subject.  
• Battery consumption is faster than in [Shooting] mode. |
| Off      | Does not use SteadyShot.                                                     |

• When shooting movies, [Continuous] is activated even if you select [Shooting].

• The anti-blur function may not work properly in the following cases.
  – When camera shake is too strong
  – When the shutter speed is slow, for example, shooting night scenes

### Auto Orientation

When the camera is rotated to shoot a portrait picture, the camera records its position information and displays the image in the portrait position.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️ On</td>
<td>Records the image with the correct orientation.</td>
</tr>
<tr>
<td>Off</td>
<td>Auto Orientation deactivated.</td>
</tr>
</tbody>
</table>
**Music**

The default settings are marked with ✔.

### Repeat

Selects the music playback mode.

<table>
<thead>
<tr>
<th>Repeat Shuffle</th>
<th>Randomly plays the track data in the “MUSIC” folder.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Repeat Track</td>
<td>Plays one track over again.</td>
</tr>
<tr>
<td>Repeat</td>
<td>Plays the track data in the “MUSIC” folder in sequence over again.</td>
</tr>
<tr>
<td>✔  Off</td>
<td>Plays back without repeating.</td>
</tr>
</tbody>
</table>

### MEGA BASS

Boosts the bass level.

<table>
<thead>
<tr>
<th>Level</th>
<th>Boosts the bass level.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level 1</td>
<td></td>
</tr>
<tr>
<td>Level 2</td>
<td></td>
</tr>
<tr>
<td>✔  Off</td>
<td>Does not use the MEGA BASS function.</td>
</tr>
</tbody>
</table>

### LCD Auto Off

While playing back the music, automatically turns off the LCD screen to save battery power if the camera is not operated for about 10 seconds (only when the camera is used with the battery pack).

<table>
<thead>
<tr>
<th>LCD Auto Off</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Turns off the LCD screen.</td>
</tr>
<tr>
<td>✔  Off</td>
<td>Does not turn off the LCD screen.</td>
</tr>
</tbody>
</table>
The default settings are marked with 🔄.

MAC address
A unique MAC address as a wireless device is assigned to each camera. Certain access point may require to register your MAC address onto the access point to permit a connection. For details, refer to the operating instructions of your access point.

Access Point
Creates or edits the profile of the wireless LAN access point. Normally, the setup of an access point is performed with [Auto Scan]. If the access point cannot be detected, follow the procedure below. Up to three profiles can be registered.

To set up an access point
① Select [Access Point] with the control button, then press ●.
② Select [New Connection], then press ●.
③ Select [Manual Settings], then press ●.
The setup screen appears.

④ Set up the following items.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection</td>
<td>Enter a connection name. Up to 16 characters can be used.</td>
</tr>
<tr>
<td>SSID</td>
<td>Enter the service set identifier of the access point. Up to 32 characters can be used.</td>
</tr>
<tr>
<td>Encryption</td>
<td>Select one of the following encryption modes: [Disabled], [WEP], [WPA-PSK(TKIP)], and [WPA2-PSK(AES)]</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password. Up to 64 characters can be used.</td>
</tr>
</tbody>
</table>
For [Connection], [SSID], [Encryption], and [Password], set them up according to your access point.

5 When setting up DHCP (Dynamic Host Configuration Protocol), select [Advanced], then press ●. The advanced setup screen appears.

6 Set up the following items, select [Save], then press ●.
   - [IP Address], [Subnet Mask], [Default Gateway], [Primary DNS], [Secondary DNS]
     - For details on the connection method, refer to the operating instructions supplied with your wireless LAN access point.

7 Select [Save], then press ●.
   The registered information is displayed.

8 Select [Exit], then press ●.

To perform a connection test
Select [Test] in step 8, then press ●.

To edit an access point
1 Select the access point you want to edit in Step 2, then press MENU.
2 Select [Edit], then press ●. Follow the process again from Step 4.

To delete an access point
1 Select the access point you want to delete in Step 2, then press MENU.
2 Select [Delete], then press ●.

**Network Power Save**

This function reduces power consumption when the device is connected to the network.

<table>
<thead>
<tr>
<th>On</th>
<th>Automatically reduces power consumption while the data is not sent/received.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Does not use the Network Power Save function.</td>
</tr>
</tbody>
</table>

* Set to [Off] in the following cases:
  - When an access point cannot be connected.
  - When there is a problem with the network connection.

**Nickname**

Specifies a nickname for your camera. This nickname is shown on the other cameras in a wireless connection.
See page 90.
**Img exchg password**

Creates or edits the use of a password when the camera is connected to another camera in Collaboration Shot or Picture Gift mode.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled</td>
<td>A password is used.</td>
</tr>
<tr>
<td>✔️ Disabled</td>
<td>No password is used.</td>
</tr>
<tr>
<td>Edit</td>
<td>Edits the password. The default setting is “000000”.</td>
</tr>
</tbody>
</table>

**To edit your password**

1. Select [Img exchg password] with the control button, then press ●.
2. Select [Edit], then press ●.
3. Input a 6-digit alphanemic password.
4. Select [OK], then press ●.
You can view images on a TV screen by connecting the camera to a TV.

Turn off both your camera and the TV before connecting the camera and the TV.

1. **Connect the camera and the Cyber-shot Station to the TV.**

   ![Diagram of camera and TV connection]

   - If your TV has a mono input jack, connect the yellow plug of A/V cable to the video input jack, then connect either the white plug or the red audio plug to the audio input jack. If connected to the white plug, you will hear sound from the left audio output, and if connected to the red plug, you will hear sound from the right audio output.
   - When the USB cable is connected to the Cyber-shot Station, disconnect the USB cable from the Cyber-shot Station.

2. **Turn on the TV and set the TV/video input switch to “video.”**

   - For details, see the operating instructions supplied with the TV.

3. **Turn on the camera.**

   Images shot with the camera appear on the TV screen.

   Move the control button to ⬅/➡ to select the desired image.
   - Characters or icons displayed on the screen may chip, depending on a TV.
   - When using your camera abroad, it may be necessary to switch the video signal output to match that of your TV system (page 64).
Viewing images on a TV screen

On TV color systems
If you want to view images on a TV screen, you need a TV with a video input jack and the A/V cable. The color system of the TV must match that of your digital still camera. Check the following lists for the TV color system of the country or region where the camera is used.

NTSC system
Bahama Islands, Bolivia, Canada, Central America, Chile, Colombia, Ecuador, Jamaica, Japan, Korea, Mexico, Peru, Surinam, Taiwan, the Philippines, the U.S.A., Venezuela, etc.

PAL system
Australia, Austria, Belgium, China, Czech Republic, Denmark, Finland, Germany, Holland, Hong Kong, Hungary, Italy, Kuwait, Malaysia, New Zealand, Norway, Poland, Portugal, Singapore, Slovak Republic, Spain, Sweden, Switzerland, Thailand, United Kingdom, etc.

PAL-M system
Brazil

PAL-N system
Argentina, Paraguay, Uruguay

SECAM system
Bulgaria, France, Guiana, Iran, Iraq, Monaco, Russia, Ukraine, etc.
This section describes the English version of screen contents.

Install the software (supplied) first (page 77)

Enjoying images using the “Album Editor” and “Picture Motion Browser” (pages 78 and 82)

- Editing the properties of an image or an album
- Copying images in the camera to your computer
- Copying images on your computer to your camera
- Importing MPEG-4 movie files to the camera
- Adding search information
- Restoring the data of the camera from a backup of a computer (Restore)
- Viewing images on your computer
- Viewing images saved on your computer
- Viewing photos organized by date
- Editing images
- Displaying the shooting locations of still images on maps online. (To do this, your computer needs to be connected to the Internet.)
- Create a new data disc. (CD burner drive or DVD burner drive required.)
- Printing or saving still images with the date inserted.
Enjoying your Windows computer

**Recommended computer environment**

The following environment is recommended for a computer connected to the camera.

**Recommended environment for using “Album Editor” and “Picture Motion Browser”**

**OS (pre-installed):** Microsoft Windows 2000 Professional (SP4 or later required), Windows XP Home Edition or Windows XP Professional

**Sound card:** 16-bit stereo sound card with speakers

**CPU/Memory:** Pentium III 1 GHz or faster, 256 MB of RAM or more

**Software:** DirectX 9.0c or later

**Hard Disk:** Disk space required for installation—200 MB or more

**Display:** Screen resolution: 1024 × 768 dots or more

**Colors:** High Color (16-bit color) or more

- The software is compatible with DirectX technology. Installation of “DirectX” may be required.

**Note on playback of movie files (MPEG-4)**

To play back movie files (MPEG-4) recorded by the camera and exported to a computer, you need to install the “Picture Motion Browser” on your computer. Movie files stored in the camera can be played back with the “Album Editor”.

**Notes on connecting your camera to a computer**

- Operations are not guaranteed for all the recommended computer environments mentioned above.
- If you connect two or more USB devices to a single computer at the same time, some devices, including your camera, may not operate, depending on the types of USB devices you are using.
- Operations are not guaranteed when using a USB hub.
- Connecting your camera using a USB interface that is compatible with Hi-Speed USB (USB 2.0 compliant) allows advanced transfer (high speed transfer) as this camera is compatible with Hi-Speed USB (USB 2.0 compliant).
- There are two modes for a USB connection when connecting a computer. [Auto] (default setting) and [Mass Storage] modes.
- When your computer resumes from a suspend or sleep mode, communication between your camera and your computer may not recover at the same time.

**Technical Support**

Additional information on this product and answers to frequently asked questions can be found at the Sony Customer Support Website.

http://www.sony.net/
You can install the software (supplied) using the following procedure.

• Log on as Administrator.

1 Turn on your computer, and insert the CD-ROM (supplied) into the CD-ROM drive.
   The installation menu screen appears.

   • If it does not appear, double-click (My Computer) → (SONYPICUTIL).

2 Click [Install].
   The “Choose Setup Language” screen appears.

3 Select the desired language, then click [Next].
   The [Location Settings] screen appears.

4 Select the [Region] and [Country/Area], then click [Next].
   When the [Welcome to the InstallShield Wizard for Sony Picture Utility] appears, click [Next].

   The “License Agreement” screen appears.
   Read the agreement carefully. If you accept the terms of the agreement, click the radio button next to [I accept the terms of the license agreement] and then click [Next].

5 Follow the instructions on the screen to complete the installation.

   • After a message that shows you to connect the camera to the computer, connect the camera to the computer as described on page 86.
   • When the restarting confirmation message appears, restart the computer following the instructions on the screen.
   • DirectX may be installed depending on system environment of your computer.

6 Remove the CD-ROM after the installation is complete.

After you install the software, a shortcut icon for the customers registration website is created on the desktop.

Once you register on the website, you can get secure and useful customer support. http://www.sony.net/registration/di
Using the “Album Editor” (supplied)

With the supplied “Album Editor”, you can use a computer to easily search for images or to edit the settings of the album and the properties of the images stored in the camera. This section summarizes the “Album Editor” and gives the basic instructions.

“Album Editor” overview

With the “Album Editor”, you can:
- Edit the properties of an image or an album
- Copy images in the camera to a computer
- Copy images on a computer to the camera
- Add search information
- Restore the data of the camera from a backup of a computer (Restore)
- Import MPEG-4 movie files to the camera
  This camera supports the following MPEG-4 movie format files
  - Memory Stick video format
  - QVGA 15 fps (384 kbps), QVGA 30 fps (768 kbps), VGA 30 fps (3 Mbps) format files
However, movie files that were recorded by certain devices or software may not be played back
- For details on the “Album Editor”, refer to the Help.

To access the Help, click [Start] → [All Programs] (in Windows 2000, [Programs]) → [Sony Picture Utility] → [Help] → [Album Editor].

Starting the “Album Editor”

Connect a computer with the Cyber-shot Station using the supplied USB cable, and press the CONNECT button on the Cyber-shot Station. Main display appears on the screen.

Exiting the “Album Editor”

Click the button on the upper right corner of the screen.

Basic instructions

Editing the properties of an image

Select an image on the main display and double-click it.

The properties display appears.

You can enter a comment or edit the label.
Using the “Album Editor” (supplied)

Editing the properties of an album

Select an album on the main display. Right-click it and select [Properties].

The properties display appears.

You can enter an album name and a comment or set the date and time.

Copying an image to a computer

This function copies all the images in the camera to a computer. The image that has been copied to the computer before will not be retrieved. Only the images that have never been retrieved will be copied.

1 Click [Import] on the main display.

The import confirmation display appears.

2 Click [OK].

To import album by album, select the album and select [Edit] → [Album] → [Copy to computer].
Copying an image from a computer to the camera
You can copy an image saved on a computer to the camera.

1 Click [File] → [Export to Camera] on the main display.
The export to camera wizard appears.

2 Select the folder that contains the image to be copied to the camera and click [Next].

3 Select the rules for dates and time and click [OK].

Adding search information
By adding search information, you can fully utilize the search function of this camera.

Click [File] → [Analyze Images] on the main display.
The analyzing image display appears.

Back up all data stored in the camera
In case of accidental data corruption, backing up your data stored in the camera on a regular basis is recommended.

1 Click [Back up Camera Data] from the Tool menu.

2 Select a destination folder.

3 Click [OK].
All data stored in the camera is backed up in the selected folder.
Using the “Album Editor” (supplied)

Restoring the data of the camera from a backup of a computer (Restore)

If an error occurs in the camera data on connecting the camera to a computer, an error message appears.

1 Click [Start] → [All Programs] (In Windows 2000, [Programs]) → [Sony Picture Utility] → [G1 Restore Tool].

2 Select a backup file.

3 Click [OK].

Restoring starts. The restore cannot be canceled halfway.

Other functions

This camera is also equipped with the functions:
• Dividing an album
• Editing labels
• Deleting or protecting images
• For details, refer to the Help.

Uninstalling “Album Editor”

1 Click [Start] → [Control Panel], (In Windows 2000, [Start] → [Settings] → [Control Panel]), then double-click [Add/Remove Programs].

2 Select [Album Editor], then click [Remove] (In Windows 2000, [Change/Remove]) to execute the uninstallation.
Using the “Picture Motion Browser” (supplied)

You can use still images and movies from the camera more than ever by taking advantage of the software. This section summarizes the “Picture Motion Browser” and gives the basic instructions.

“Picture Motion Browser” overview

With the “Picture Motion Browser” you can:

• Organize images on the computer on a calendar by shooting date to view them.
• Retouch, print, and send still images as e-mail attachments, change the shooting date, and more.
• Still images can be printed or saved with the date.
• You can create a data disc using a CD burner drive or DVD burner drive.
• For details on the “Picture Motion Browser”, refer to the Help.

To access the Help, click [Start] → [All Programs] (in Windows 2000, [Programs]) → [Sony Picture Utility] → [Help] → [Picture Motion Browser].

Starting and exiting the “Picture Motion Browser”

Starting the “Picture Motion Browser”

Double-click the  (Picture Motion Browser) icon on the desktop.
Or, from the Start menu: Click [Start] → [All Programs] (in Windows 2000, [Programs]) → [Sony Picture Utility] → [Picture Motion Browser].

• The confirmation message of the Information tool appears on the screen when starting the “Picture Motion Browser” for the first time. Select [Start]. This function informs you of news, such as software updates. You can change the setting later.

Exiting the “Picture Motion Browser”

Click  button in the top right corner of the screen.

Basic instructions

Follow these steps to view images from the camera.

Viewing images

1 Checking imported images

When the “Picture Motion Browser” runs, thumbnails of the imported images are displayed.

To view images:

• The “My Pictures” folder is set as the default folder in “Viewed folders”.
• You can double-click a thumbnail to display the image by itself.

2 Viewing images in “Viewed folders” arranged by shooting date on a calendar

① Click the [Calendar] tab. Years when images were shot are listed.
② Click the year. Images shot that year are displayed, arranged on the calendar by shooting date.
③ To display images by month, click the desired month. Thumbnails of images shot that month are displayed.
Using the “Picture Motion Browser” (supplied)

4 To display images by time, click the desired date. Thumbnails of images shot that day are displayed, arranged by hour.

3 Displaying individual images

On the hour display screen, double-click a thumbnail to display the image by itself in a separate window.

• You can edit displayed images by clicking the toolbar button.

Displaying images in full-screen mode

To display a slide show of current images in full-screen mode, click the button.

• To play or pause the slide show, click the button on the lower left of the screen.
• To stop the slide show, click the button on the lower left of the screen.

• To list images from a particular year or month, click that period on the left of the screen.
Creating a data disc

Images can be saved in CD or DVD as a data disc.
• CD burner drive or DVD burner drive required.
• The following disc can be used for creating a data disc.
  – CD-R/RW (12cm)
  – DVD±R/RW (12cm)
  – DVD+R DL (12cm)

1 Select images to save on the disc.
  • To select two or more adjacent images, click the first image, then hold down the “Shift” key and click the next image(s).
  • To select two or more unadjacent images, hold down the “Ctrl” key and click the other image(s).

2 Click the \button on the tool bar.
The [Create Data Disc] display appears.

3 Click [Start].

4 Follow the display instructions to proceed with creating the data disc.
  • To add desired images, drag and drop on the [Create Data Disc] display.

Selecting all images in a folder
Click the [folders] tab, then right-click on the desired folder icon and select [Create Data Disc]. All images in a folder can be selected.

Using Map View to display still images on a map

If your still images have position information, you can see the images on maps online with Map View.
• To use the Map View function, your computer needs to be connected to the Internet.

1 Select a thumbnail marked with \.

2 Click .
The Map View main window appears.

• Maps and satellite images powered by Google Maps mapping service.

• You can later add position information on the still images, using the Map View. For details, see the Help of Map View.
Updating image registration information

To update image information, choose [Update Database] from the [Tools] menu.
• Updating the database may take a while.
• If you rename image files or folders in “Viewed folders”, they cannot be displayed with this software. In this case, update the database.

Saving images with the date

1. Double-click an image to display it.
2. Click 📒 and select [Insert Date] from the drop-down list.
3. Select your desired color and position, and then click [OK].
4. Click 📒 to save.

Printing images with the date

1. Select the still image you want to print.
2. Click 📒 on the toolbar.
3. Click the check box of [Print date taken] in Print Options.
4. Click [Print].

To uninstall the “Picture Motion Browser”

1. Click [Start] ➔ [Control Panel] (in Windows 2000, [Start] ➔ [Settings] ➔ [Control Panel]), then double-click [Add/Remove Programs].
2. Select [Sony Picture Utility], then click [Remove] (in Windows 2000, [Change/Remove]) to execute the uninstallation.
Connecting the camera and your computer with Mass Storage

## Connecting the camera and your computer

Connect the camera as illustrated below and then press the CONNECT button on the Cyber-shot Station.

1. Double-click [My Computer] → [Removable Disk] → [DCIM].
2. Double-click the folder where the image files you want to copy are stored. Then, right-click an image file to display the menu and click [Copy].
3. Double-click the [My Documents] folder. Then, right-click on the “My Documents” window to display the menu and click [Paste].

## Copying images to the camera

1. Click [Start] → [My Documents].
2. Right-click the image file, then click [Copy].
3. Double-click [My Computer] → [Removable Disk] → [DCIM]. Right-click the file, then click [Paste].

   - When you copy images to the camera with the Mass Storage connection, perform [Scan Images] (page 59).

## To delete the USB connection

Perform the procedures listed below beforehand when:

- Disconnecting the USB cable
- Removing a “Memory Stick Duo”
- Inserting a “Memory Stick Duo” into the camera after copying images from the internal memory
- Turning off the camera

1. Double-click 🔄 on the tasktray.
2. Click 🔄 (USB Mass Storage Device) → [Stop].
3. Confirm the device on the confirmation window, then click [OK].
4. Click [OK].

   The device is disconnected.

   - Step 4 is unnecessary for Windows XP.
Connecting the camera and your computer with Mass Storage

Image file storage destinations and file names

Example: viewing folders on Windows XP

A Folder containing image data recorded using this camera
When not creating any folders, there is only the “101MSDCF” folder

B Folder containing movie data that were recorded using your camera
When not creating any folder, there is only the “101MNV01” folder

C Folder containing MP3 file data that were imported to your camera

D This folder may not appear on the screen, depending on your Windows setting.
The DATA folder contains data, such as information used for album display or image search. If you erase or edit these data, album display and search functions do not work properly. Never erase or edit data contained in the DATA folder.

• You cannot record/play back any images to the “MISC” folder.
• Image files are named as follows. □□□□ stands for any number within the range from 0001 to 9999.
  – Still image files: DSC□□□□.JPG
  – Movie files: MOV□□□□.MPG
• For more information about folders, see pages 45 and 57.
A wireless LAN function is equipped with this camera. There are two types of connection. The available range of the wireless LAN function (among DSC-G1s or between the DSC-G1 and an access point) depends on surroundings or condition. The maximum range is about 10 to 30 m (32 feet 9 3/4 inches to 98 feet 5 1/8 inches).

**Note on data transmission**

The camera transmits its unique information, such as a nickname of the camera, to destination devices during data communication with other devices via a wireless LAN network.

### Exchanging images among the DSC-G1s

Directly establishes a connection among the DSC-G1s without an access point (Ad-hoc mode).
- Nicknames need to be assigned before this operation (page 90).

Up to four cameras can be connected.
- When there are two networks each consisting of two cameras, you cannot establish a connection between the two networks.
What you can do with a network connection

To connect four cameras via a network
Validating the connection can only be performed between two cameras at one time. In order to connect four cameras together, first validate the connection between two cameras, then validate the connection between the network of the two cameras and the third camera. After that, repeat the process with the fourth camera.

Shoot a picture and transfer it simultaneously → Collaboration Shot (page 91)
An image shot with your camera or your partners’ cameras can be recorded on each camera at the same time.

Exchange images while selecting them on playback screen → Picture Gift (page 93)
You can transfer an image stored in your camera to your partners’ cameras.

Making your images public via an access point (not supplied) (page 95)
Connects to a network via an access point (Infrastructure mode).
• The access point needs to be configured before the operation (pages 70, 95).
Assigning a nickname to the camera

You can give the camera a nickname using up to ten characters. This nickname will be displayed when the camera is validated by other DSC-G1s connected with a wireless LAN connection.

- You must use at least one character when assigning a nickname.

Connecting for the first time

The nickname setting display comes on before the connection display appears. You cannot proceed to the connection display unless the nickname setting process is completed.

1. Press HOME and select [Settings] → [Network] → [Nickname] with the control button, then press .

   The nickname setting display appears.

2. Enter a nickname of your choosing and select [OK], then press .

To cancel a nickname entering process

Select [Cancel], then press . The nickname remains the same.

How to use the character input tool

To enter a character

Select a letter of the alphabet or a number with the control button, then press . The selected character is entered.

To change the types of characters

Selecting [A/a/@] will switch the keyboard of the character input tool in the following order: Lower case alphabet → Upper case alphabet → Symbols.

To delete a character

Place the cursor behind the character to be deleted using [←/→]. Select [Back space], then press . The character in front of the cursor is deleted.
Collaboration Shot

An image captured with this camera can automatically be sent to other cameras connected via a wireless connection. Up to four cameras can share the image.

1 In still image shooting mode, press WLAN.

When a nickname has not been entered, the nickname setting display appears (page 90).

- This step can be done by going to [Communication] \rightarrow [Collaboration Shot] from the home display.

2 After message “Press WLAN button on other device at same time” appears, press WLAN simultaneously.

“Connecting...” appears. Once the connection is established, the image sharing area is displayed along with the shooting area.

3 To connect the third device, simultaneously press WLAN of either the first or the second device along with that of the third device.

4 To connect the fourth device, simultaneously press WLAN of one of the first three devices along with that of the fourth device.

5 Shoot your image.

The image is uploaded to all other connected cameras.
About the display in Collaboration Shot mode

- **A** Image being monitored
- **B** A list of all connected users
  - Each user is separated by color.
- **C** The latest image you and all other connected users shot
- **D** The history of the images you and all other connected users shot
  - **↓**: Downloading
  - **↓↓**: Download complete
  - **×**: Download failed

Press the DISP (Screen display switch) button to switch the display.

Multi-angle

- **A** Image being monitored
- **B** Connected user
- **C** The history of the images the connected user shot
- **D** The latest image the connected user shot
  - **↓**: Downloading
  - **↓↓**: Download complete
  - **×**: Download failed

About the shared image

- The data of the shared image is saved as a new file.
- To identify who shot a particular shared image, a bar indicator of the same color as the user name appears underneath the history of that image.
- Images captured with other devices are registered in the same album, and an Album Image is also generated.

To sever the connection

Hold down the WLAN (Wireless network) button for more than two seconds.
Make sure the indicator of the WLAN button is not illuminated.

- You cannot use continuous shooting, exposure bracket shooting, or movie recording while performing a collaboration shooting operation.
Picture Gift

You can exchange an image stored on this camera with other DSC-G1s connected via a wireless connection.

1. In playback mode, press WLAN.
   - When a nickname has not been entered, the nickname setting display appears (page 90).
   - This step can be done by going to [ ] (Communication) → [ ] (Picture Gift) from the home display.

2. After message “Press WLAN button on other device at same time” appears, press WLAN simultaneously.
   - “Connecting...” appears. Once the connection is established, the mode selection screen appears.

3. Select a Picture Gift mode, then press ●.
   - [Give Image]: Image sending mode
   - [Get Image]: Image receiving mode
   - The share image screen or the image receiving screen appears.

4. To connect a third device, simultaneously press WLAN of either the first or the second device along with that of the third device.

5. To connect a fourth device, simultaneously press WLAN of one of the first three devices along with that of the fourth device.

Sending an image

To select an image to be made public

Select the image to be made public with the control button, then press ●. The image is indicated with the ↑ mark, and the process of making the image accessible to other users begins.

When the user granting access selects an image to be shared, the device on the receiving side displays the image in the index display area.

To cancel this operation, select the image again, then press ●. The ↑ mark disappears from the image.

To send all the images in an album

Select the frame of the album with the control button (page 25). The process of making all of the images in the album accessible to other users begins.
**Receiving an image**

**To select the image to receive**
Select the image you want to receive with the control button, then press ●. The image is indicated with the ↓ mark, and the process of receiving the image begins. To cancel receiving of the image, select the image again, then press ●. The ↓ mark disappears from the image.

**To receive all the images in an album**
Select the frame of the album with the control button (page 25). The process of receiving all of the images in the album begins.

- You cannot cancel the operation once the download is complete.

**To switch between image sending mode and image receiving mode**

**About the display in Picture Gift mode**

---

**Image sending**

A Image transferring bar  
B The number of images downloaded/  
   The number of images to be downloaded  
   ↑: Sending  
   ↓: Downloading  
   ↓: Download complete  
C A list of all connected users  
   Each user is separated by color.

**To end the exchange**
Press MENU and select [Exit], then press ●.

**To sever the connection**
Hold down the WLAN (Wireless network) button for more than two seconds. Make sure the indicator of the WLAN button is not illuminated.
Viewing images via a Wireless LAN

With a DLNA-enabled TV set, you can view the images stored in this camera via an access point without connecting the devices via an A/V cable.

• If the access point has already been configured, you can skip steps 2 through 5.

1 Turn on the camera and the TV.

2 Select [ ] (Settings) → [Network] → [Access Point] with the control button, then press ●.

3 Select [Auto Scan] with the control button, then press ●.

   The search result is displayed.

   • If the access point cannot be detected, perform [Manual Settings] (page 70).

4 Select the desired access point with the control button, then press ●.

5 When a password is required, enter the password, select [Exit] with the control button, then press ●.

Select [Password], then press ●. The character input tool appears. Enter the password. Select [OK], then press ●.

6 Select [ ] (Toolbox) → [Share Images] with the control button, then press ●.

7 Select [OK] with the control button, then press ●.

   The image selection screen appears.

• It may take several seconds to a few minutes to establish a connection.
**8 Select the images (page 24).**

Pressing the MENU button turns on the image share screen ( [Clear All], [Go To Album], [Keyword], [Keyword Off], [Details]).

Images of the camera are currently shared with a DLNA-enabled device. To view the images with a DLNA-enabled device, setup and some operations of a playback device are required. For details, see the operating manual of the playback device.

- Only a photo server function is equipped with this camera.
- This camera is compliant with the DLNA standards to connect with a VAIO Media, Loom Link, BRAVIA, etc.
When you print images shot in [16:9] mode, both edges may be cut off, so be sure to check before printing (page 112).

**Printing directly using a PictBridge compliant printer (page 98)**

You can print images by connecting the camera directly to a PictBridge compliant printer.

**Printing directly using a “Memory Stick” compliant printer**

You can print images with a “Memory Stick” compliant printer. For details, see the operating instructions supplied with the printer.

**Printing using a computer**

You can copy images to a computer and print the images using the supplied “Picture Motion Browser” software. You can insert the date on the image and print it (page 85).

**Printing at a shop**

You can take a “Memory Stick Duo” containing images shot with your camera to a photo printing service shop. The DPOF function is not equipped with the camera.
Printing images directly using a PictBridge compliant printer

Even if you do not have a computer, you can print images shot using your camera by connecting the camera directly to a PictBridge compliant printer.

**PictBridge**

- “PictBridge” is based on the CIPA standard. (CIPA: Camera & Imaging Products Association)
- If the ! indicator flashes on the screen of the camera (error notification), check the connected printer.

**Stage 1: Preparing the camera**

Prepare the camera to connect it to the printer with the USB cable. When connecting the camera to a printer that is recognized when [USB Connect] is set to [Auto], Stage 1 is unnecessary.

1. Press HOME to display the home screen.

2. Select [ ] (Settings) → [ ] Main] → [ Preferences] with the control button, then press ●.

3. Select [USB Connect] with the control button, then press ●.

4. Select [PictBridge] with the control button, then press ●.

   The USB mode is set.

- It is recommended to use a fully charged battery pack or the AC Adaptor with the camera installed on the Cyber-shot Station to prevent the power from turning off partway through printing.
Stage 2: Connecting the camera to the printer

Connect the camera as illustrated below and then press the CONNECT button on the Cyber-shot Station.

1. Connect the camera as illustrated.
2. Press the CONNECT button on the Cyber-shot Station.

Stage 3: Printing

1. Turn on your camera and the printer.

2. Select whether to print Album Images or to print images in the “Memory Stick Duo”.

   After your choosing, the image selection screen appears.
   → “Selecting multiple images” (page 24)

3. Set up the print options with the control button.

   [Quantity]
   When the [Layout] is set to [1-up/Borderless] or [1-up/Border]:
   Select the number of sheets of an image that you want to print. The image will be printed as a single image.

   When the [Layout] is not set to [1-up/Borderless] or [1-up/Border]:
   Select the number of sets of images that you want to print as an index image.
When you are performing index printing, the images may not fit in a sheet of paper, depending on the number you specified.

[Layout]
Specify the number of images to be printed on a sheet of paper.

[Size]
Select the size of the printing sheet.

[Date]
Select [Day&Time] or [Date] to insert the date and time on images.
• When you choose [Date], the date will be inserted in the order you select (page 65). This function may not be provided depending on the printer.

4 Select [OK] with the control button, then press ●.

The image is printed.
• Do not disconnect the USB cable while the (PictBridge Connecting) indicator appears on the screen.
You can play back MP3 files stored in the “MUSIC” folder in the internal memory.

- Note that this camera does not support ATRAC3 and ATRAC3plus formats. This camera supports only MP3 format files.
- To import tracks from a CD, compliant software is required. For details, refer to an instruction manual of the software, etc.

**Importing music files**

This section describes an example of importing music files to the “My Music” folder.

1. **Connect the camera Cyber-shot Station and your computer (page 86).**

   ![USB cable diagram](image)

   - ① To a USB jack
   - ② To the (USB) jack

2. **Click [Start] → [My Music].**

   The contents of the “My Music” folder are displayed.

3. **Right-click the desired music file, then click [Copy].**

4. **Double-click [My Computer] → [Removable Disk] → [MUSIC].**

   Then, right-click on the “My Music” window to display the menu and click [Paste].

   The music file is imported to the “MUSIC” folder.

   For details on the folder configuration, see page 87.

   - You can create two-stage folders under the “MUSIC” folder and name the folders. For example, “MUSIC”
     - “Artist name”
     - “Album name”
     - “Album name”
   - You can play back tracks wherever the tracks are located in the folder.
Listening to music

Playing back music

1 Press HOME and select [🎵] (Music) → [🎵] Audio Player with the control button, then press ●.

The player screen appears.

2 Press ●.

Playback starts from the previous stopped point.

The player screen

- Track name
- Elapsed time
- Total time of the track
- Artist name
- Album name

To deactivate the buttons
Press $.

To pause
Press ●.

To skip to the next/previous track
Move the control button to ←/→.

To adjust the volume
Move the control button to ↑/↓ to adjust the volume.

To select the desired track
① Press MENU to display the menu.
② Select [▶] (Choose Track) with the control button, then press ●.
The track selection screen appears.

③ Select the track you want to play back, then press ●.
The menu options

You can use the following options. For details on these options, see the following pages.

<table>
<thead>
<tr>
<th>Item</th>
<th>Setting</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>[MEGA BASS] (Off)</td>
<td>[MEGA BASS] (Level 1)</td>
<td>69</td>
</tr>
<tr>
<td>[MEGA BASS] (Level 2)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(Repeat)</td>
<td>[Repeat]</td>
<td>69</td>
</tr>
<tr>
<td></td>
<td>[Repeat Track]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Repeat Shuffle]</td>
<td></td>
</tr>
<tr>
<td>(AVLS)</td>
<td>(Off)</td>
<td>61</td>
</tr>
<tr>
<td></td>
<td>(On)</td>
<td></td>
</tr>
<tr>
<td>(LCD Auto Off)</td>
<td>(Off)</td>
<td>69</td>
</tr>
<tr>
<td></td>
<td>(On)</td>
<td></td>
</tr>
</tbody>
</table>

To use headphones (not supplied)

The (Headphones) jack is equipped with the camera and it supports headphones with the stereo minijack. Setting [AVLS] to [On] on the home screen limits the volume to protect your hearing and to reduce sound leaking into the environment around you (page 61).

- Certain data cannot be played back.
If you experience trouble with your camera, try the following solutions.

1. **Check the items on pages 105 to 114.**
   If a code such as “C/E:□□:□□” appears on the screen, see page 115.

2. **Remove the battery pack, and insert the battery pack again after about one minute, and turn on the power.**

3. **Press the RESET button located on the bottom using a fine-tipped object, and turn on the power.**
   If you do the operation above, the date and time setting is cleared.

4. **Consult your Sony dealer or local authorized Sony service facility.**

Please understand that you give your consent that the contents of the internal memory, Music files may be checked when you send your camera to be repaired.

Click one of the following items to jump to the page explaining the symptom and cause or the appropriate corrective action.

- **Battery pack and power** 105
- **Picture Motion Browser** 111
- **Shooting still images/movies** 105
- **“Memory Stick Duo”** 112
- **Viewing images** 108
- **Internal memory** 112
- **Deleting/Editing images** 108
- **Printing** 112
- **Network** 109
- **PictBridge compliant printer** 113
- **Computers** 110
- **Others** 114
- **Album Editor** 111
Troubleshooting

**Battery pack and power**

**The battery pack cannot be installed.**

- Install the battery pack correctly using the tip of the battery pack to push the battery eject lever outward.

**Cannot turn on the camera.**

- Install the battery pack correctly.
- The battery pack is discharged. Install the charged battery pack.
- The battery pack is dead (page 122). Replace it with a new one.
- Use a recommended battery pack.
- The lens cover is not fully opened. Open the cover until it clicks.

**The power turns off suddenly.**

- If you do not operate the camera for about three minutes while the power is on, the camera turns off automatically to prevent wearing down the battery pack. Turn on the camera again.
- The battery pack is dead (page 122). Replace it with a new one.

**The battery remaining indicator is incorrect.**

- This phenomenon occurs when you use the camera in an extremely hot or cold location.
- The displayed battery remaining differs from the current one. Fully discharge and then charge the battery pack to correct the display.
- The battery pack is discharged. Install the charged battery pack.
- The battery pack is dead (page 122). Replace it with a new one.

**Shooting still images/movies**

**Your camera cannot record images.**

- Check the free capacity of the internal memory or “Memory Stick Duo”. If it is full, do one of the following:
  – Delete unnecessary images (page 23).
  – Change the “Memory Stick Duo”.
- When the free capacity of the internal memory is not sufficient, you cannot record images even if the “Memory Stick Duo” has enough capacity. This is because the camera records an Album Image to the internal memory at the same time. Delete unnecessary images (page 23).
- You are using the “Memory Stick Duo” with the write-protect switch, and the switch is set to the LOCK position. Set the switch to the recording position (page 120).
- You cannot record images while charging the flash.
- The selection of the Movie/Photo mode is not correct. Set the mode using the #/ (Movie/Photo) button.
Troubleshooting

Anti-blur function does not work.

• The anti-blur function does not work when “Off” appears on the display.
• The anti-blur function may not work properly when shooting night scenes.
• Shoot after pressing the shutter button halfway down; do not press it fully down suddenly.

Recording takes a long time.

• The NR slow shutter function is activated (page 13). This is not a malfunction.

The image is out of focus.

• The subject is too close. Shoot in (Macro) recording mode. Make sure to position the lens farther away from the subject than the shortest shooting distance, approximately 8 cm (3 1/4 inches) (W)/25 cm (9 7/8 inches) (T), when shooting. Or, set (Magnifying Glass) and focus from a distance of approx. 1 cm to 20 cm (13/32 inch to 7 7/8 inches) from the subject (page 20).
• (Magnifying Glass) is set, or (Hand-held Twilight mode), (Twilight mode), (Landscape mode) or (Fireworks mode) is selected in the Scene Selection mode when shooting still images.
• The Focus preset function is selected. Select the auto focus mode (page 35).
• Refer to “If the subject is out of focus” on page 36.

Zoom does not work.

• When (Magnifying Glass) is selected, the optical zoom is not available.

The flash does not work.

• The flash is set to (Flash forced off) (page 20).
• You cannot use the flash when:
  – The camera shoots with Burst or Exposure Bracket mode (page 39).
  – (High Sensitivity mode), (Hand-held Twilight mode), (Twilight mode) or (Fireworks mode) is selected in the Scene Selection mode (page 33).
  – Shooting movies.
• Set the flash to (Flash forced on) when (Magnifying Glass) is set, or (Landscape mode), (Hi-Speed Shutter mode), (Beach mode), or (Snow mode) is selected in the Scene Selection mode (page 20).

Fuzzy specks appear in images shot using the flash.

• Dust in the air reflected the flash light and appeared in the image. This is not a malfunction.

The close-up shoot function (Macro/Magnifying Glass) does not work.

• (Hand-held Twilight mode), (Twilight mode), (Landscape mode) or (Fireworks mode) is selected in the Scene Selection mode (page 32).
Troubleshooting

The date and time are not displayed.
• While shooting, the date and time are not displayed. They are displayed only during playback.

The F value and shutter speed flash when you press and hold the shutter button halfway down.
• The exposure is incorrect. Correct the exposure (page 34).

The screen is too dark or too bright.
• Adjust the brightness of the LCD backlight (pages 16, 62).

The image is too dark.
• You are shooting a subject with a light source behind the subject. Select the metering mode (page 37) or adjust the exposure (page 34).

The image is too bright.
• Adjust the exposure (page 34).

Vertical streaks appear when you are shooting a very bright subject.
• The smear phenomenon is occurring. This phenomenon is not a malfunction.

Noise appears in the image when you view the screen in a dark place.
• The camera is attempting to increase the visibility of the screen by temporarily brightening the image under conditions of low illumination. There is no effect on the recorded image.

The eyes of the subject come out red.
• Set [Red Eye Reduction] to [Auto] (page 67).
• Shoot the subject at a distance closer than the flash range using the flash.
• Light the room and shoot the subject.

Dots appear and remain on the screen.
• This is not a malfunction. These dots are not recorded (page 2).

Cannot shoot images in succession.
• The internal memory or “Memory Stick Duo” is full. Delete unnecessary images (page 23).
• The battery level is low. Install a charged battery pack.
• The Magnifying Glass mode is selected.
Viewing images

Your camera cannot play back images.
- There is no Album Image because you imported the image from a computer to the camera using a Mass Storage connection. Perform [Scan Images] (page 59).
- The folder/file name has been changed on your computer. Perform [Scan Images] (page 59).
- When an image file has been processed by a computer or when the image file was recorded using a model other than that of your camera, playback on your camera is not guaranteed.
- The camera is in USB mode. Delete the USB connection (page 86).

The date and time are not displayed.
- The shooting information is not set to be displayed. Switch the display pattern using the DISP (Screen display switch) button (page 16).

The image appears rough right after playback starts.
- The image may appear rough right after playback starts due to image processing. This is not a malfunction.

The image does not appear on the screen when a USB connection is made.
- Disconnect the USB cable (page 86).

The image does not appear on the TV screen.
- Check [Video Out] to see if the video output signal of your camera is set to the color system of your TV (page 64).
- Check whether the connection is correct (page 73).

Deleting/Editing images

Your camera cannot delete an image.
- Cancel the protection (page 47).
- You are using the “Memory Stick Duo” with the write-protect switch, and the switch is set to the LOCK position. Set the switch to the recording position (page 120).

You have deleted an image by mistake.
- Once you have deleted an image, you cannot restore it. We recommend that you protect images (page 47), or use the “Memory Stick Duo” with the write-protect switch and set the switch to the LOCK position (page 120) to prevent accidental erasure.

The resizing function does not work.
- You cannot resize movies.
You cannot establish a connection with the Wireless LAN access point.

• Check to make sure the power of the Wireless LAN access point is on.
• The communication range may be shortened by the surrounding conditions, such as various obstacles, radio wave traffic, and the wall material between this camera and the Wireless LAN access point. Change the location of the camera or move the camera closer to the access point.
• Microwave ovens or Bluetooth-enabled devices use the 2.4 GHz wavelength and could hinder the communication. If such devices are in the vicinity, move the camera away from those devices or shut those devices down.
• For further information on how to establish a connection, refer to the operating manual of the Wireless LAN access point.

You cannot exchange an image in Collaboration Shot or Picture Gift mode.

• The communication range may be shortened by the surrounding conditions, such as various obstacles, radio wave traffic, and the wall material between the devices. Change the location or move the devices closer together.
• Microwave ovens or Bluetooth-enabled devices use the 2.4 GHz wavelength and could hinder the communication. If such devices are in the vicinity, move away from those devices or shut those devices down.

It takes too much time to transfer an image.

• The communication range may be shortened by the surrounding conditions, such as various obstacles, radio wave traffic, and the wall material between the devices or between this camera and the Wireless LAN access point. Change the location of the devices, put the devices closer together, or move the camera closer to the access point.
• You may be getting a crossed connection with another Wireless LAN access point. Set the wireless channel at the Wireless LAN access point. For further information, refer to the operating manual of the Wireless LAN access point.
• Microwave ovens or Bluetooth-enabled devices use the 2.4 GHz wavelength and could hinder the communication. If such devices are in the vicinity, move the camera away from those devices or shut those devices down.

You cannot connect to a hotspot (public Wireless LAN access point) service.

• This camera does not support connection to hotspot services.
Troubleshooting

Computers

You do not know if the OS of your computer is compatible with the camera.

• Check “Recommended computer environment” on page 76 for Windows.

“Memory Stick PRO Duo” is not recognized by a computer with a “Memory Stick” slot.

• Check that the computer and the Memory Stick Reader/Writer support “Memory Stick PRO Duo”. Users of computers and Memory Stick Readers/ Writers made by manufacturers other than Sony should contact those manufacturers.
• If “Memory Stick PRO Duo” is not supported, connect the camera to the computer (page 86). The computer recognizes the “Memory Stick PRO Duo”.

Your computer does not recognize your camera.

• Turn on the camera.
• Press the CONNECT button (page 86).
• Set [USB Connect] to [Mass Storage] (page 63).
• Use the USB cable (supplied) (page 86).
• Disconnect the USB cable from both the computer and the Cyber-shot Station, and connect it again firmly.
• Disconnect all equipment other than the camera, the keyboard and the mouse from the USB connectors of your computer.
• Connect the camera directly to your computer without passing through a USB hub or other device (page 86).

You cannot copy images.

• Connect the camera and your computer correctly making a USB connection (page 86).
• When you shoot images with a “Memory Stick Duo” formatted by a computer, you may not be able to copy the images to a computer. Shoot using a “Memory Stick Duo” formatted by your camera (page 57).

The image cannot be played back on a computer.

• If you are using “Album Editor” or “Picture Motion Browser,” refer to the Help.
• “Picture Motion Browser” is required to play back a movie file (MPEG-4) recorded with this camera.

The image and sound are interrupted by noise when you view a movie on a computer.

• You are playing back the movie directly from the internal memory or the “Memory Stick Duo”. Copy the movie to the hard disk of your computer, then play back the movie from the hard disk (page 86).
Troubleshooting

You cannot print an image.

- Refer to the operation manual of the printer.

Images once copied to a computer cannot be viewed on the camera.

- Copy them to a folder recognized by the camera, such as “101MSDCF” (page 87).
- Operate correctly (page 86).

**Album Editor**

You cannot find images imported with “Album Editor”.

- Look in the “My Pictures” folder.

Images cannot be exported from your computer to the camera.

- You can export each folder from your computer to your camera. You cannot export image by image and you cannot add images to the album on your camera.
- You can export images with extensions such as “.jpg,” “.jpeg,” or “.mp4,” from your computer to your camera. Other images cannot be exported to your camera.

An error occurred and the album was not displayed.

- When the camera is connected to the computer, if there is an abnormality in the data inside the camera, an error message is displayed. Disconnect the camera from the computer, and check that the images can be played back normally on the camera. If the images are still not displayed correctly, perform restore. Once you restore the data, the images that were shot after the backup will be lost.

The restore function cannot be used.

- You cannot restore data if there is no backed up data to be restored. We recommend that you back up the data on a regular basis in case the data is corrupted for some reason.
- If you cannot perform restore, format the camera’s internal memory, and then try restoring again. All of the data inside the camera is deleted when format is performed.

**Picture Motion Browser**

Images are not displayed correctly with “Picture Motion Browser”.

- Make sure the folder of the images is registered in “Viewed folders”. If the images are not displayed even if the folder is registered in “Viewed folders”, update the database (page 85).

All imported images are displayed on the calendar with the date January 1.

- The date has not been set on the camera. Set the date on the camera (page 65).
Troubleshooting

“X” is indicated

• Select [Update Database] from the [Tools] menu, then execute the function (page 85).

“Memory Stick Duo”

Cannot insert a “Memory Stick Duo”.

• Insert it in the correct direction.

Cannot format a “Memory Stick Duo”.

• You are using the “Memory Stick Duo” with the write-protect switch, and the switch is set to the LOCK position. Set the switch to the recording position (page 120).

You have formatted a “Memory Stick Duo” by mistake.

• All the data on the “Memory Stick Duo” is deleted by formatting. You cannot restore it. We recommend that you set the write-protect switch on the “Memory Stick Duo” to the LOCK position to prevent accidental erasure (page 120).

When connected to a USB port, the “Memory Stick Duo” is not recognized as a removable disk.

• Depending on the device you established a USB connection with, it is possible that only the contents of internal memory are recognized. Either import the necessary photos into internal memory or use a personal computer to copy them to internal memory.

Internal memory

Cannot copy the data stored in the internal memory to a “Memory Stick Duo”.

• The “Memory Stick Duo” is full. Check the capacity.

A data error occurred in the internal memory.

• Restore the data of the camera from a backup of the computer (page 81). However, the data that is newer than the backup will be erased.

Printing

Also see “PictBridge compliant printer” (as follows) in conjunction with the following items.

Images are printed with both edges cut off.

• Depending on your printer, the left, right, top, and bottom edges of the image may be cut off. Especially when you print an image shot with the image size set to [16:9], the edge of the image may be cut off.
• When printing images using your own printer, try canceling the trimming or borderless settings. Consult the printer manufacturer as to whether the printer provides these functions or not.
• When having images printed at a digital print shop, ask the shop whether they can print the images without cutting off both edges.
Cannot print images with the date inserted.

- You can print images with the date inserted using “Picture Motion Browser”.
- This camera does not have a feature for superimposing dates on images. However, because the images shot with the camera include information on the recording date, you can print images with the date superimposed if the printer or the software can recognize Exif information. For compatibility with Exif information, consult the manufacturer of the printer or the software.
- When you print images at a shop, images can be printed with the date inserted if you ask them to do so.

A connection cannot be established.

- The camera cannot be connected directly to a printer that is not compliant with the PictBridge standard. Consult the printer manufacturer as to whether the printer is compliant with PictBridge or not.
- Check that the printer is turned on and can be connected to the camera.
- Set [USB Connect] to [PictBridge] (page 63).
- Disconnect and connect the USB cable again. If an error message is indicated on the printer, refer to the operating instructions supplied with the printer.

Cannot print images.

- Check that the camera and the printer are properly connected using the USB cable.
- Turn on the printer. For further information, refer to the operating instructions supplied with the printer.
- If you select [Exit] during printing, images may not be printed. Disconnect and connect the USB cable again. If you still cannot print your images, disconnect the USB cable, turn the printer off and then on, then connect the USB cable again.
- Movies cannot be printed.
- Images shot using cameras other than this camera or images modified with a computer may not be printed.

Printing is canceled.

- You disconnected the USB cable before the (PictBridge Connecting) mark disappears.

Cannot insert the date or print images in the index mode.

- The printer does not provide these functions. Consult the printer manufacturer as to whether the printer provides these functions or not.
- The date may not be inserted in the index mode depending on the printer. Consult the printer manufacturer.

“---- -- --” is printed on the date-inserted part of the image.

- Images that do not have the recording data cannot be printed with the date inserted. Set [Date] to [Off] and print the image again (page 100).
Troubleshooting

Cannot select the print size.
• Consult the printer manufacturer as to whether the printer can provide the desired size.

Cannot print the image at the size selected.
• Disconnect the USB cable and reconnect it whenever you change the paper size after the printer has been connected to the camera.
• The print setting of the camera differs from that of the printer. Change the setting of either the camera (page 100) or the printer.

Cannot operate the camera after canceling printing.
• Wait for a while as the printer is carrying out the cancellation. It may take some time depending on the printer.

Others

Music files cannot be played back.
• If the file names or folder names are longer, the tracks may not be displayed.

The volume does not increase.
• [AVLS] is set to [On]. Set it to [Off] (page 61).

The lens gets fogged.
• Moisture condensation has occurred. Turn off the camera and leave it for about an hour before using it.

The camera becomes warm when you use it for a long time.
• This is not a malfunction.

The Clock Set screen appears when you turn on the camera.
• Set the date and time again (page 65).

You want to change the date or time.
• Set the date and time again (page 65).
Warning indicators and messages

**Self-diagnosis display**

If a code starting with a letter of the alphabet appears, your camera has a self-diagnosis display. The last two digits (indicated by □□) will differ depending on the state of the camera. If you are unable to solve the problem even after trying the following corrective actions a few times, your camera may need repair. Contact your Sony dealer or local authorized Sony service facility.

**C:32:□□**
- There is trouble with your camera’s hardware. Turn the power off and on again.

**C:13:□□**
- The camera cannot read or write data on the “Memory Stick Duo”. Try turning off and on the camera again, or taking out and inserting the “Memory Stick Duo” several times.
- The internal memory has experienced a format error, or an unformatted “Memory Stick Duo” is inserted. Format the internal memory or the “Memory Stick Duo” (pages 57, 59).
- The inserted “Memory Stick Duo” cannot be used with your camera, or the data is damaged. Insert a new “Memory Stick Duo”.

**E:61:□□**
**E:62:□□**
**E:91:□□**
- A camera malfunction has occurred. Press the RESET button (page 104), then turn the power on again.

**Messages**

If the following messages appear, follow the instructions.

![Message Icon]
- The battery level is low. Charge the battery pack immediately. Depending on the conditions of use or the type of battery pack, the indicator may flash even though there are still 5 to 10 minutes of remaining battery time left.

**For "InfoLITHIUM" battery only**
- This battery pack is not a “InfoLITHIUM” type.

**System error**
- Turn the power off and then on again.

**Album data error**
- Perform [Check Album] (page 56).

**Internal memory error**
- Turn the power off and then on again.

**Reinsert the Memory Stick**
- Insert the “Memory Stick Duo” correctly.
- The inserted “Memory Stick Duo” cannot be used in your camera (page 120).
- The “Memory Stick Duo” is damaged.
- The terminal section of the “Memory Stick Duo” is dirty.

**Memory Stick type error**
- The inserted “Memory Stick Duo” cannot be used in your camera (page 120).
Warning indicators and messages

Internal memory formatting error
Memory Stick formatting error
• Format the media again (pages 57 and 59).

Memory Stick locked
• You are using the “Memory Stick Duo” with the write-protect switch, and the switch is set to the LOCK position. Set the switch to the recording position (page 120).

No memory space in internal memory
No memory space on Memory Stick
• Delete unnecessary images or files (page 23).

Not enough space in internal memory to store album images
• Delete unnecessary data in the internal memory. This is because the camera records Album Images in the internal memory even when you use a “Memory Stick Duo”.

Read only memory
• Your camera cannot record or delete images on this “Memory Stick Duo”.

No file
• No playable images have been recorded in the internal memory.

Folder error
• A folder with the same first three digit number already exists on the “Memory Stick Duo” (for example: 123MSDCF and 123ABCDE). Select another folder, or create a new folder (pages 57, 58).

Cannot create more folders
• The folder with a name beginning with “999” exists on the “Memory Stick Duo”. You cannot create any folders if this is the case.

Cannot record
• The camera cannot record images in the selected folder. Select a different folder (page 58).

File error
• An error occurred while the image or music file was playing back.

File protect
• Release the protection (page 48).

Image size over
• You are playing back an image of a size that cannot be played back on your camera.

Invalid operation
• You are trying to play back or edit a file that is not compatible with the camera.

(Vibration warning indicator)
• Camera shake may occur due to insufficient light. Use the flash, turn on the anti-blur function, or mount the camera on a tripod to secure the camera.

Check other device
• [USB Connect] is set to [PictBridge], however the camera is connected to a non-PictBridge compliant device. Check the device.
• The connection is not established. Disconnect and connect the USB cable again. If an error message is indicated on the printer, refer to the operating instructions supplied with the printer.
Connect to PictBridge device
• You tried to print images before the printer connection was established. Connect to a PictBridge compliant printer.

No printable image
• You attempt to print when you select a folder that contains only movies.

Printer busy

Paper error
No Paper
Ink error
Low Ink
No Ink
• Check the printer.

Printer error
• Check the printer.
• Check if the image you want to print is corrupted.

✦
• The data transmission to the printer may not be completed yet. Do not disconnect the USB cable.

Processing...
• The printer is canceling the current print job. You cannot print until it is finished. This may take time, depending on the printer.

Action invalid with more than 2 cameras
• Before connecting the third device, press the WLAN buttons on the first two devices simultaneously and establish a connection between them (page 89).

Could not find access point
Cannot connect
• Confirm the access point and retry establishing a connection.

Disconnected
• The network is disrupted. Retry establishing a connection.

No images
• There is no image that fits the “Narrow Down” condition.

No similar images
• No similar images have been detected.
To use your camera abroad — Power sources

You can use your camera and the AC-LS5 AC Adaptor (supplied) in any country or region where the power supply is within 100 V to 240 V AC, 50/60 Hz. Use a commercially available AC plug adaptor [a], if necessary, depending on the design of the wall outlet (wall socket) [b].

- Do not use an electronic transformer (travel converter), as this may cause a malfunction.

Setting to the local time

You can easily set the clock to the local time by setting a time difference when using your camera abroad. Select [ ] (Settings) → [ Clock Set] → [Area] and [Daylight Savings] from the home screen (page 65).
## World Time Difference

<table>
<thead>
<tr>
<th>Time-zone differences</th>
<th>Area setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>GMT</td>
<td>Lisbon, London</td>
</tr>
<tr>
<td>+01:00</td>
<td>Berlin, Paris</td>
</tr>
<tr>
<td>+02:00</td>
<td>Helsinki, Cairo, Istanbul</td>
</tr>
<tr>
<td>+03:00</td>
<td>Moscow, Nairobi</td>
</tr>
<tr>
<td>+03:30</td>
<td>Tehran</td>
</tr>
<tr>
<td>+04:00</td>
<td>Abu Dhabi, Baku</td>
</tr>
<tr>
<td>+04:30</td>
<td>Kabul</td>
</tr>
<tr>
<td>+05:00</td>
<td>Karachi, Islamabad</td>
</tr>
<tr>
<td>+05:30</td>
<td>Calcutta, New Delhi</td>
</tr>
<tr>
<td>+06:00</td>
<td>Almaty, Dhaka</td>
</tr>
<tr>
<td>+06:30</td>
<td>Rangoon</td>
</tr>
<tr>
<td>+07:00</td>
<td>Bangkok, Jakarta</td>
</tr>
<tr>
<td>+08:00</td>
<td>Hong Kong, Singapore, Beijing</td>
</tr>
<tr>
<td>+09:00</td>
<td>Seoul, Tokyo</td>
</tr>
<tr>
<td>+09:30</td>
<td>Adelaide, Darwin</td>
</tr>
<tr>
<td>+10:00</td>
<td>Melbourne, Sydney</td>
</tr>
<tr>
<td>+11:00</td>
<td>Solomon Is.</td>
</tr>
<tr>
<td>+12:00</td>
<td>Fiji, Wellington</td>
</tr>
<tr>
<td>–12:00</td>
<td>Eniwetok, Kwajalein</td>
</tr>
<tr>
<td>–11:00</td>
<td>Samoa</td>
</tr>
<tr>
<td>–10:00</td>
<td>Hawaii</td>
</tr>
<tr>
<td>–09:00</td>
<td>Alaska</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Time-zone differences</th>
<th>Area setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>–08:00</td>
<td>San Francisco, Tijuana</td>
</tr>
<tr>
<td>–07:00</td>
<td>Denver, Arizona</td>
</tr>
<tr>
<td>–06:00</td>
<td>Chicago, Mexico City</td>
</tr>
<tr>
<td>–05:00</td>
<td>New York, Bogota</td>
</tr>
<tr>
<td>–04:00</td>
<td>Santiago</td>
</tr>
<tr>
<td>–03:30</td>
<td>St. John’s</td>
</tr>
<tr>
<td>–03:00</td>
<td>Brasilia, Buenos Aires</td>
</tr>
<tr>
<td>–02:00</td>
<td>Fernando de Noronha</td>
</tr>
<tr>
<td>–01:00</td>
<td>Azores, Cape Verde Is.</td>
</tr>
</tbody>
</table>
On the “Memory Stick”

A “Memory Stick” is a compact, portable IC recording medium. The types of “Memory Stick” that can be used with this camera are listed in the table below. However, proper operation cannot be guaranteed for all “Memory Stick” functions.

### “Memory Stick” type | Recording/Playback
---|---
Memory Stick (without MagicGate) | —
Memory Stick (with MagicGate) | —
Memory Stick Duo (without MagicGate) | ○
Memory Stick Duo (with MagicGate) | ○*1*2
MagicGate Memory Stick | —
MagicGate Memory Stick Duo | ○*1*
Memory Stick PRO | —
Memory Stick PRO Duo | ○*1*2

*1 “Memory Stick Duo”, “MagicGate Memory Stick Duo” and “Memory Stick PRO Duo” are equipped with MagicGate functions. MagicGate is copyright protection technology that uses encryption technology. Data recording/playback that requires MagicGate functions cannot be performed with this camera.

*2 Supports high-speed data transfer using a parallel interface.

- A “Memory Stick Duo” formatted with a computer is not guaranteed to operate with this camera.
- Data read/write speeds differ depending on the combination of the “Memory Stick Duo” and the equipment used.

---

**Notes on using a “Memory Stick Duo” (not supplied)**

- You cannot record, edit or delete images if you slide the write-protect switch to LOCK with a fine-tipped object.

![Terminal](image)

The position and/or the shape of the write-protect switch may differ depending on the “Memory Stick Duo” you use.

- Do not remove the “Memory Stick Duo” while reading or writing data.
- Data may be corrupted in the following cases:
  - When the “Memory Stick Duo” is removed or the camera is turned off during a read or write operation
  - When the “Memory Stick Duo” is used in locations subject to static electricity or electrical noise
- We recommend backing up important data.
- Do not press down hard when you write down on the memo area.
- Do not attach a label on the “Memory Stick Duo” itself nor on a Memory Stick Duo Adaptor.
- When you carry or store the “Memory Stick Duo”, put it in the case supplied with it.
- Do not touch the terminal section of the “Memory Stick Duo” with your hand or a metal object.
- Do not strike, bend or drop the “Memory Stick Duo”.
- Do not disassemble or modify the “Memory Stick Duo”.
- Do not expose the “Memory Stick Duo” to water.
- Do not leave the “Memory Stick Duo” within the reach of small children. They might accidentally swallow it.
On the “Memory Stick”

• Do not use or store the “Memory Stick Duo” under the following conditions:
  – High temperature locations such as the hot interior of a car parked in direct sunlight
  – Locations exposed to direct sunlight
  – Humid locations or locations with corrosive substances present

Notes on using the Memory Stick Duo Adaptor (not supplied)

• To use a “Memory Stick Duo” with a “Memory Stick” compliant device, be sure to insert the “Memory Stick Duo” into a Memory Stick Duo Adaptor. If you insert a “Memory Stick Duo” into a “Memory Stick” compliant device without a Memory Stick Duo Adaptor, you might not be able to remove it from the device.

• When inserting a “Memory Stick Duo” into a Memory Stick Duo Adaptor, make sure the “Memory Stick Duo” is inserted facing in the correct direction, then insert it all the way in. Incorrect insertion may result in a malfunction.

• When using a “Memory Stick Duo” inserted into a Memory Stick Duo Adaptor with a “Memory Stick” compliant device, make sure that the Memory Stick Duo Adaptor is inserted facing the correct direction. Note that improper use may damage the equipment.

• Do not insert a Memory Stick Duo Adaptor into a “Memory Stick” compliant device without a “Memory Stick Duo” attached. Doing so may result in malfunction of the unit.

Notes on using “Memory Stick PRO Duo” (not supplied)

“Memory Stick PRO Duo” with a capacity up to 8 GB have been confirmed to operate properly with this camera.
On the “InfoLITHIUM” battery pack

This camera requires an “InfoLITHIUM” battery pack (R type).

What is an “InfoLITHIUM” battery pack?
An “InfoLITHIUM” battery pack is a lithium-ion battery pack that has functions for exchanging information related to operating conditions with your camera. The “InfoLITHIUM” battery pack calculates the power consumption according to the operating conditions of your camera, and displays the remaining battery time in minutes.

On charging the battery pack
We recommend charging the battery pack in an ambient temperature of between 10°C to 30°C (50°F to 86°F). You may not be able to efficiently charge the battery pack outside of this temperature range.

Effective use of the battery pack
• Battery performance decreases in low temperature surroundings. So, the time that the battery pack can be used is shorter in cold places. We recommend the following to ensure longer battery pack use:
  – Put the battery pack in a pocket close to your body to warm it up, and insert it in your camera immediately before you start shooting.
• The battery pack will run out quickly if you use the flash or zoom frequently.
• We recommend having spare battery packs handy for two or three times the expected shooting time, and making trial shots before taking the actual shots.
• Do not expose the battery pack to water. The battery pack is not water-resistant.
• Do not leave the battery pack in extremely hot places, such as in a car or under direct sunlight.

On the remaining battery time indicator
The power may go off although the battery remaining indicator shows there is enough power to operate. Use the battery pack up and charge the battery pack fully again so that the indication on the battery remaining indicator is correct. Note, however, that the correct battery indication sometimes will not be restored if the battery pack is used in high temperatures for a long time, left in a fully charged state or used frequently.

How to store the battery pack
• If the battery pack is not to be used for a long time, fully charge it and then fully use it up once a year on your camera before storing the battery pack in a dry, cool place. Repeat this charging and using up once a year to maintain the battery pack’s function.
• To use the battery pack up, leave your camera in slide show (page 42) playback mode until the power goes off.
• To prevent staining the terminal, short-circuiting, etc., be sure to use a supplied battery case when carrying and storing.

On battery life
• The battery life is limited. Battery capacity decreases little by little as you use it more and more, and as time passes. If the battery operating time seems shortened considerably, a probable cause is that the battery pack has reached the end of its life. Buy a new battery pack.
• The battery life varies according to how it is stored and the operating conditions and environment in which each battery pack is used.
A/V cable ................................ 73
Access Point .......................... 70
Adjusting Exposure ................ 34
AE/AF lock indicator .............. 19, 36
AF Illuminator ...................... 67
AF lock ................................. 36
AF Mode .............................. 66
AF range finder frame ............ 35
Album .................................. 7, 45
Album Editor ......................... 78
Auto adjustment mode .......... 18
Auto Orientation ..................  68
AVLS .................................... 61

B
Battery pack .......................... 122
Beach mode .......................... 32
Beep ...................................... 61
Burst ...................................... 39

C
Center AF ................................ 35
Center-weighted metering .... 37
Change REC. Folder ............. 58
Check Album ......................... 56
Clock Set ............................... 65
Cloudy .................................. 37
Collaboration Shot ............... 91
Computer .............................. 75
Copying ................................ 79, 86
Recommended environment .... 76
Software ............................... 77
Windows ............................... 75
Connecting ............................
Computer .............................. 86
Printer ................................. 99
TV ........................................ 73

D
Date .............................. 65, 107, 113
Daylight ............................... 37
Daylight Savings .................. 65
DC IN jack ............................ 11
Default Media ....................... 56
Delete .................................. 23, 47
Format .................................. 57, 59
Details .................................. 53
Digital Zoom ......................... 67
DirectX ................................ 76

E
Electronic transformer .... 118
EV ........................................ 34
Export ................................... 52
Exposure Bracket ................ 39

F
File name ............................... 87
File Number .......................... 56
File storage destination ....... 87
Find ..................................... 51
Fireworks mode ................. 32
Flash .................................... 20, 38
Flash forced off .................... 20
Flash forced on ..................... 20
Flash Level ......................... 40
Flash mode ......................... 20
Fluorescent ......................... 38
Focus .................................. 35
Focus preset ......................... 35
Folder
Changing ............................. 58
Creating .............................. 57
Go To Folder ....................... 45
Format .................................. 57, 59
Fully Format ......................... 60
Function Guide ..................... 62

H
Hand-held Twilight mode .... 32
High Sensitivity mode ......... 32
Hi-Speed Shutter mode ....... 32
Holding the camera ............ 18
HOME Design ...................... 62

I
Identifying parts ................... 10
Image file storage destinations
and file names ................... 87
Image Size ............................ 22, 66
Img exchg password ............ 72
Import ................................... 52
Incandescent ....................... 38
Index screen ....................... 24
Indicator .............................. 12
“InfoLITHIUM” battery pack
................................ 122
Initialize .............................. 63
Install ................................... 77
Internal Memory .................. 59
ISO ...................................... 38

J
JPG ....................................... 87

K
Keyword ............................... 51

L
Label ................................. 49
Landscape mode .................. 32
Language ............................. 62
LCD Auto Off ....................... 69
LCD Brightness .................... 62
LCD Screen ............................ 16
Index

M
MAC address ........................70
Macro ....................................20
Magnifying Glass ..................20
Manage Images ......................47
Mass Storage ........................63
Media Space ........................56
MEGA BASS ..........................69
Memory Stick ......................57, 120
“Memory Stick Duo” ..............120
Menu
Items ................................30
Shooting ..............................34
Viewing ..............................45
Metering Mode ......................37
Monitor ................................66
MPG .....................................87
Multi AF ...............................35
Multi-pattern metering ...........37
Music ................................101

N
Network ................................88
Network Power Save ..............71
Nickname .............................71, 90
NR slow shutter ....................13
NTSC ..................................64

O
Optical zoom ......................19, 67

P
PAL ......................................64
PC .......................................75
PictBridge ..........................63, 98
Picture Gift ..........................93
Picture Motion Browser ........82
Playback ............................23
Playback zoom .....................23
Print ..................................97
Printing directly ....................98
Program auto shooting mode ....31
Protect ..............................47

R
REC Mode ............................39
Red Eye Reduction ...............67
Repeat ............................... 69
RESET button .......................104
Resize ............................... 48
Rewind/Fast forward ...........23
Rotate ...............................48

S
Scan Images ..........................59
Scene Selection ....................32
Screen
Changing the display ...........16
Indicator ............................12
LCD backlight ........................16
LCD Brightness .....................62
Self-diagnosis display .........115
Self-timer ............................21
Settings
Camera .............................66
Clock Set ............................65
Music ................................69
Network .............................70
Preferences ..........................63
Screen ...............................62
Sound ...............................61
Shooting
Movie ...............................19
Still image ..........................19
Shooting menu .....................34
Similar Images ..........................51
Single ...............................66
Slide Show ..........................42
Slow synchro ..........................20
Snow mode ..........................32
Soft Snap mode ....................32
Software .............................77, 82
Spot AF ...............................35
Spot metering ......................37
Spot metering cross hairs .......37
SteadyShot .........................68

T
Troubleshooting .....................104
TV .........................................73
Twilight mode ......................32
Twilight Portrait mode ..........32

U
USB cable ..........................86, 99, 101
USB Connect ........................63
Using your camera abroad .....118

V
VGA .....................................22
Video Out ............................64
Viewing
Movie ...............................23
Still image ..........................23
Viewing menu ......................45
Volume ..............................23

W
Warning indicators and messages ....115
White Balance .....................37
Windows computer ...............75
Recommended environment ..76
Wireless LAN .......................95
Write-protect switch ..............120

Z
Zoom ..................................19
Additional information on this product and answers to frequently asked questions can be found at our Customer Support Website.

http://www.sony.net/